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Technical Support
Symantec Technical Support maintains support centers globally. Technical Support’s
primary role is to respond to specific queries about product features and functionality.
The Technical Support group also creates content for our online Knowledge Base.
The Technical Support group works collaboratively with the other functional areas
within Symantec to answer your questions in a timely fashion. For example, the
Technical Support group works with Product Engineering and Symantec Security
Response to provide alerting services and virus definition updates.

Symantec’s support offerings include the following:

■ A range of support options that give you the flexibility to select the right amount
of service for any size organization

■ Telephone and/or Web-based support that provides rapid response and
up-to-the-minute information

■ Upgrade assurance that delivers software upgrades

■ Global support purchased on a regional business hours or 24 hours a day, 7
days a week basis

■ Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our website at
the following URL:

support.symantec.com

All support services will be delivered in accordance with your support agreement
and the then-current enterprise technical support policy.

Contacting Technical Support
Customers with a current support agreement may access Technical Support
information at the following URL:

www.symantec.com/business/support/

Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be at
the computer on which the problem occurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

■ Product release level

■ Hardware information

https://support.symantec.com
http://www.symantec.com/business/support/


■ Available memory, disk space, and NIC information

■ Operating system

■ Version and patch level

■ Network topology

■ Router, gateway, and IP address information

■ Problem description:

■ Error messages and log files

■ Troubleshooting that was performed before contacting Symantec

■ Recent software configuration changes and network changes

Licensing and registration
If your Symantec product requires registration or a license key, access our technical
support Web page at the following URL:

www.symantec.com/business/support/

Customer service
Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the
following types of issues:

■ Questions regarding product licensing or serialization

■ Product registration updates, such as address or name changes

■ General product information (features, language availability, local dealers)

■ Latest information about product updates and upgrades

■ Information about upgrade assurance and support contracts

■ Information about the Symantec Buying Programs

■ Advice about Symantec's technical support options

■ Nontechnical presales questions

■ Issues that are related to CD-ROMs, DVDs, or manuals

http://www.symantec.com/business/support/
http://www.symantec.com/business/support/


Support agreement resources
If you want to contact Symantec regarding an existing support agreement, please
contact the support agreement administration team for your region as follows:

customercare_apac@symantec.comAsia-Pacific and Japan

semea@symantec.comEurope, Middle-East, and Africa

supportsolutions@symantec.comNorth America and Latin America
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Introducing Asset
Management Suite

This chapter includes the following topics:

■ About Asset Management Suite

■ Components of Asset Management Suite

■ What you can do with Asset Management Suite

■ Where to get more information

About Asset Management Suite
Asset Management Suite provides a management console, a database environment
and a number of solutions that let you track assets and asset-related information.
The suite includes Asset Management Solution and CMDB Solution. Asset
Management Suite specializes in tracking IT-related assets, such as computers
and software. You can also use it to track other types of assets, such as furniture
and company cars.

In association with assets, you can record and track many types of documents and
documented details. For example, you can track lease schedules, NDAs
(non-disclosure agreements), SLAs (Service Level Agreements), and warranty
information. Contracts and contract details can be associated with assets so that
you can easily view the contractual information that is related to specific assets.
You can also configure the software so that it notifies you of the upcoming actions
that are specified in a contract.

See “What you can do with Asset Management Suite” on page 12.

You can use the Symantec Management Console to view the value of an asset or
a group of assets. You can also view the department, cost center and user that is
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assigned to an asset. You can keep track of software license details so that you
avoid paying for the licenses that you do not need.

Additionally, Asset Management Suite aligns with IT Infrastructure Library (ITIL)
standards. It also helps you comply with international IT standards such as COBIT
and U.S. federal laws such as the Sarbanes-Oxley Act and HIPAA.

Components of Asset Management Suite
Asset Management Suite is a collection of solutions and components that run on
the Symantec Management Platform. Click the links to view individual release notes
of the components.

Table 1-1 Components of Asset Management Suite

Link to User GuideDescriptionComponent

DOC9469Symantec Management Platform provides a set of services that
IT-related solutions can leverage. The platform services also
provide a high degree of consistency between the solutions, so
that users do not need to learn multiple product interfaces.

Symantec Management Platform includes the following
components:

■ Configuration Management Database (CMDB)
■ Notification Server
■ Symantec Management Console
■ Symantec Management Agent for Windows, and for UNIX,

Linux, and Mac
■ Network Discovery
■ Software Management Framework
■ Reports

Symantec
Management
Platform

DOC9302Asset Management Solution lets you set up and manage different
asset management processes throughout the life cycle of your
assets. You can manage the acquisition of your assets, on-going
costs, contracts, and software license compliance.

Asset Management
Solution

DOC9590CMDB Solution lets you model configuration items, resources,
and the relationships between them in a central database. It lets
you facilitate the identification of all components and relationships,
and instigate any required changes. The solution actively manages
resources according to user-specified instructions in jobs, tasks,
configuration policies, and custom CMDB rules.

CMDB Solution
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What you can do with Asset Management Suite
Asset Management Suite helps you accurately value your assets, track ownership
and maintain associations with related documents.

See “About Asset Management Suite” on page 10.

Asset Management Suite provides predefined templates and quick-start processes
that help you do the following:

Asset Management Suite helps you track assets and other
resources. For each asset type that you want to track, you create
a corresponding configuration item in the system. Templates are
provided to help you create items for computers, printers, phones,
furniture, and other assets.

After you create items for each asset, you can create configuration
items for the details that you want to associate with the assets.
You then specify the associations between the asset items and
other items in your environment. For example, you can associate
a computer with its purchase order, location and user. Reports
and filters help you determine the status of the assets in your
environment.

See “Managing configuration items” on page 30.

Manage configuration
items.

Asset Management Suite helps you track software licenses and
applications. You create configuration items for software licensing
elements in your environment. You then associate these
license-related items with other information in your system.

Asset Management Suite provides the templates that let you create
software products, software licenses and software purchases.
Reports and filters help you determine your software license
compliance and requirements.

See “Managing your software license compliance using the
Software view” on page 69.

See “Managing your software license compliance on the Asset
Management Solution pages” on page 86.

Manage your software
license compliance.
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Procurement processes are the processes of obtaining new
objects, assets, or devices for your company.

Asset Management Suite provides the templates that help you
create and manage procurement-related configuration items. You
can track assets and resources from the initial procurement
process to the eventual disposal. You can run reports and use
filters to determine the procurement status of items in your
environment.

See “Performing the procurement” on page 64.

Manage your
procurement process.

Asset Management Suite helps you manage and track your
contracts. The contract item specifies the details of the agreement
and includes attached source documents.

Asset Management Suite provides the templates that let you create
contracts, lease schedules, NDAs (non-disclosure agreements)
and warranties.

See “Setting up the environment for managing contracts”
on page 49.

Manage contracts.

Where to get more information
Use the following documentation resources to learn about and use this product.

Table 1-2 Documentation resources

LocationDescriptionDocument

The Supported Products A-Z page, which is available at
the following URL:

https://www.symantec.com/products/products-az

Open your product's support page, and then underCommon
Topics, click Release Notes.

Information about new
features and important
issues.

Release Notes

■ The Documentation Library, which is available in the
Symantec Management Console on the Help menu.

■ The Supported Products A-Z page, which is available
at the following URL:
https://www.symantec.com/products/products-az
Open your product's support page, and then under
Common Topics, click Documentation.

Information about how to
use this product,
including detailed
technical information and
instructions for
performing common
tasks.

User Guide
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Table 1-2 Documentation resources (continued)

LocationDescriptionDocument

The Documentation Library, which is available in the
Symantec Management Console on the Help menu.

Context-sensitive help is available for most screens in the
Symantec Management Console.

You can open context-sensitive help in the following ways:

■ Click the page and then press the F1 key.
■ Use the Context command, which is available in the

Symantec Management Console on the Help menu.

Information about how to
use this product,
including detailed
technical information and
instructions for
performing common
tasks.

Help is available at the
solution level and at the
suite level.

This information is
available in HTML help
format.

Help

In addition to the product documentation, you can use the following resources to
learn about Symantec products.

Table 1-3 Symantec product information resources

LocationDescriptionResource

Knowledge BaseArticles, incidents, and
issues about Symantec
products.

SymWISE Support
Knowledgebase

Unified Help SystemAll available IT
Management Suite and
solution guides are
accessible from this
Symantec Unified Help
System that is launched
on cloud.

Cloud Unified Help System

14Introducing Asset Management Suite
Where to get more information

http://www.symantec.com/business/theme.jsp?themeid=support-knowledgebase
http://help.symantec.com/Welcome?context=ITMS8.1


Table 1-3 Symantec product information resources (continued)

LocationDescriptionResource

The links to various groups on Connect are as follows:

■ Deployment and Imaging
■ Discovery and Inventory
■ ITMS Administrator
■ Mac Management
■ Monitor Solution and Server Health
■ Patch Management
■ Reporting
■ ServiceDesk and Workflow
■ Software Management
■ Server Management
■ Workspace Virtualization and Streaming

An online resource that
contains forums, articles,
blogs, downloads,
events, videos, groups,
and ideas for users of
Symantec products.

Symantec Connect
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Setting up Asset
Management Suite

This chapter includes the following topics:

■ Required components of a fully functional Asset Management Suite environment

■ About installing Asset Management Suite

■ About licensing Asset Management Suite

■ Checking license usage

Required components of a fully functional Asset
Management Suite environment

Asset Management Suite lets you manage assets in your environment, set cost
data and manage the services and the licenses that are associated with the assets.

See “About Asset Management Suite” on page 10.

To achieve a fully functional Asset Management Suite environment, the following
components must be present in your network:

You need a server that provides Active Directory services.Active Directory server

Mail server is used to send out the notifications that are related to
asset management processes.

Mail server

On the SQL server, you set up the Configuration Management
Database (CMDB).

SQL server
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On Notification Server, you install the following components of
Asset Management Suite:

■ Asset Management Solution
Asset Management Solution lets you set up and configure the
asset management processes.
See “What you can do with Asset Management Suite”
on page 12.

■ CMDB Solution
CMDB Solution lets you manage your data in the Configuration
Management Database (CMDB).
For more information, see the topics about what you can do
with CMDB Solution in the CMDB Solution User Guide.

■ Data Connector
Data Connector lets you import and export resource data
between numerous external data sources and the CMDB. For
example, you can import organizational view and group
memberships and resource filter membership information. You
can also export reports.

Notification Server

About installing Asset Management Suite
Before you install Asset Management Suite, make sure that your server environment
meets the requirements for Symantec Management Platform.

For more information, see the topics about installing Symantec Management Platform
products in the IT Management Suite Install and Upgrade Guide at the following
URL:

http://www.symantec.com/docs/DOC9500

About licensing Asset Management Suite
Each solution in Asset Management Suite includes a trial license. You can register
and obtain extended trial licenses at Symantec Web site, www.symantec.com. You
can also purchase full product licenses.

For more information, see the topics about applying licenses to a solution in the IT
Management Suite Planning for Implementation Guide at the following URL:

http://www.symantec.com/docs/DOC9470

See “About Asset Management Suite” on page 10.
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Checking license usage
The License Usage page lets you monitor the number of Asset Management
Solution licenses that you own and that are in use.

A license is consumed each time you log in to the Symantec Management Console
and use Asset Management Solution functions. Asset Management Solution
functions include software licensing, viewing or editing a contract, and viewing or
editing a purchase order.

Asset Management Solution is licensed per concurrent connection. For example,
if you simultaneously log in to the Symantec Management Console on two different
computers and use Asset Management Solution functions on both computers, two
licenses are consumed.

See “About Asset Management Suite” on page 10.

To check license usage

1 In the Symantec Management Console, on the Settings menu, click All
Settings.

2 In the left pane, expand Service and Asset Management > Asset
Management Solution, and then click License Usage.
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Managing your
organizational structure

This chapter includes the following topics:

■ Setting up your organizational structure

Setting up your organizational structure
Asset Management Suite lets you create and maintain associations among
organizations, assets and resources. For example, you can associate a computer
with a user, a department and a location. You can also associate a department with
a specific cost center. After you specify these logical groups and associations, you
can keep track of an asset. You can track where an asset is located, who has it,
and which department or cost center has responsibility for it.

Before you can create the associations, you must add organizational configuration
items into the Configuration Management Database (CMDB). The organizational
configuration item types let you enter organizational data and define the structure
of your organization. Organizational configuration item types are the essential
building blocks upon which all of your other asset and contract data is based. Later,
when you create entries for assets and other configuration items, you can then
associate these items with the organizational information that already exists.

Organizational configuration item types support a hierarchy for organizing the
resources. Organizing information in a hierarchy simplifies management and access
to the data. You can view information at different levels of detail. For example, you
can look at the reports for all computers in a building, on a site, in a geographical
region, or at company level.

Before you enter any data, consider your organizational needs and the relationships
that the resources have with each other. Symantec recommends that you plan and
set up organizational configuration items at the beginning. However, you can update
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and edit the organizational configuration items later. When you create an
organizational configuration item, you can specify all data, including the association
data. While you specify the association for a configuration item type, you can create
an associated configuration type too. For example, you can specify a location for
an asset from the already-created locations. Alternatively, you can create a new
location from the same window, and then associate the newly-created location to
the asset.

To create a configuration item, right-click a configuration item type, and then click
the context menu option that lets you create a new configuration item.

Note: Ideally, you would enter all data for a configuration item at once, and then
move on to the next configuration item. However, when you create an organizational
configuration item, it is often not possible. Organizational configuration items have
associations with each other.

After you enter your organizational data and associate it with assets, contracts and
users, the system automatically creates organizational groups under the
organizational views. Organizational groups offer a great benefit when you want to
manage your assets by location or department. For example, you can apply policies
and tasks separately to the different resource targets that you create from the
organizational groups. You can also create and configure site-specific security roles
to restrict each asset management team, so that they can only view and manage
assets of their own sites.

See “Managing security on an organizational group” on page 27.

For more information, see the topics about organizational views and groups, and
configuring resource security in the IT Management Suite Administration Guide.

Table 3-1 Process for setting up your organizational structure

DescriptionActionStep

The location organizational type lets you add geographical or physical
locations into the Configuration Management Database (CMDB).

See “Creating a location” on page 21.

Create locations.Step 1

The cost center organizational type lets you add your company's cost centers
into the CMDB.

Note that if you enter cost center data but have not created a location, you
cannot specify a location for a cost center.

See “Creating a cost center” on page 22.

Create cost centers.Step 2
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Table 3-1 Process for setting up your organizational structure (continued)

DescriptionActionStep

The department organizational type lets you add your company's departments
into the CMDB.

If you enter department data but have not created a location and a cost
center, you cannot create the associations for a department.

See “Creating a department” on page 23.

Create departments.Step 3

The user configuration item type lets you enter data about people in your
company into the CMDB.

See “Creating a user” on page 24.

Create users.Step 4

When you set up your organizational structure in the Symantec Management
Console, the organizational items do not appear in theOrganizational Views
and Groups list until the organizational hierarchy gets updated. By default,
the automatic update runs every 30 seconds and updates the organizational
hierarchy.

If you have disabled the automatic updating of organizational hierarchy, you
must use the Update Organizational Hierarchy task to manually refresh
the hierarchy.

See “Updating your organizational hierarchy manually” on page 25.

(Optional) Update the
organizational hierarchy
manually.

Step 5

Creating a location
The Location organizational type lets you add geographical or physical locations
into the Configuration Management Database (CMDB). If your company has multiple
sites around the world, you can use the geographical locations, such as country,
state and city, to create a location for each site. You can then associate the assets
of each site with the locations that you define. Physical locations, such as building,
floor and cubicle, let you create separate locations at a single site. You can then
associate assets of each building, floor or cubicle to their corresponding locations.

You can associate each location with its manager and with a cost center. When
you enter data for a location, you can also specify the hierarchy for it. For example,
you can create a location for the United States, and then create sub-locations for
the states, such as California, Utah, and Texas.

Note that on the Location page, all location items are displayed in the flat list. You
can see the hierarchy of the locations on the Organizational Views and Groups
page.

For more information, see the topics about organizational views and groups in the
IT Management Suite Administration Guide.
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This task is a step in the process for setting up your organizational structure.

See “Setting up your organizational structure” on page 19.

To create a location

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Manage Configuration Items.

2 In the left pane, expand Organizational Types.

3 Right-click Location and click Create Location.

4 In the Create configuration item window, in the Location box, type the name
of the location, and then fill in the location information.

5 (Optional) To create a hierarchy, in the Location Hierarchy section, specify
the parent location for the item that you currently edit.

You can also first insert all locations, and then add a parent location to a group
of locations at once. To add a parent location to a group of locations, do the
following:

■ Select the locations to which you want to add the parent location.

■ In the list of locations, right-click one a location, and then click CMDB
Functions > Assignment Functions > Assign Parent Location.

■ In the Select a Report dialog box, select the parent location, and then click
OK.

6 (Optional) If you enter the Location To Subnet parameter and then enable
the Update Network Resource Location task, the task automatically assigns
this location to the network devices that belong to the specified subnet.

However, you cannot assign a location to computers with multiple IP addresses
in a subnet. Use the Ignore filter to add subnet IP address that the task can
ignore. You can append the % character to IP address to filter the entire set
of IP addresses.

For more information, click the page and then press F1.

7 Click OK.

Creating a cost center
TheCost Center organizational type lets you add your company's cost centers into
the Configuration Management Database (CMDB). Cost centers are associated
with the departments or other sections of the company that create costs. For
example, an engineering department, IT department or services department can
each include one or more cost centers. The managers of these cost centers are
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responsible for approving all asset purchases and ensuring that the expenditures
are kept within budgets.

You can associate a location and a manager with each cost center. You cannot
specify a single cost center for multiple locations at once.

See “Creating a location” on page 21.

The Cost Center configuration item type lets you create a hierarchical structure of
the cost centers in your company. Note that on the Cost Center page, all cost
center items are displayed in the flat list. You can see the hierarchy of the cost
centers on theOrganizational Views andGroups page (Manage >Organizational
Views and Groups).

For more information, see the topics about organizational views and groups in the
IT Management Suite Administration Guide.

This task is a step in the process for setting up your organizational structure.

See “Setting up your organizational structure” on page 19.

To create a cost center

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Manage Configuration Items.

2 In the left pane, expand Organizational Types.

3 Right-click Cost Center and click Create Cost Center.

4 In the Create configuration item window, give the cost center a name and
specify the Cost Center Code.

You use Cost Center Code value for accounting related data.

5 Fill in the cost center data.

6 (Optional) To create a child cost center, in the Cost Center Hierarchy section,
select a parent cost center.

7 Click OK.

Creating a department
The Department organizational type lets you add your company's departments
into the Configuration Management Database (CMDB). You associate each
department with a location, a cost center and a barcode that is used for physical
audits. The Department configuration item type also lets you specify a manager
for the department.

When you enter the data for a department, you can specify its hierarchical position
within the company. You can see the hierarchy of the departments on the
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Organizational Views andGroups page. On theDepartment page, all departments
are displayed in the flat list.

For more information, see the topics about organizational views and groups in the
IT Management Suite Administration Guide.

This task is a step in the process for setting up your organizational structure.

See “Setting up your organizational structure” on page 19.

To create a department

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Manage Configuration Items.

2 In the left pane, expand Organizational Types.

3 Right-click Department and click Create Department.

4 In the Create configuration item window, give the department a name and
fill in the department data.

5 (Optional) To create a child department, in Department Hierarchy section,
select a parent department.

6 Click OK.

Creating a user
The User configuration item type lets you enter data about people in your company
into the Configuration Management Database (CMDB). The User configuration
item type is associated with the company and the department configuration item
types. You can also specify a manager for a user.

When you use Asset Management Suite for the first time, you do not have to insert
user data manually. Symantec recommends that you use Microsoft Active Directory
Import to enter all your company's existing users into the CMDB. If the user data
that you import also contains department data, you can use it to automatically assign
users to the departments. To accomplish this task, you must enter the department
data before you import the user data.

You can add users manually in the Symantec Management Console when you
need to add a few users at a time. For example, when you add information about
new hires.

This task is a step in the process for setting up your organizational structure.

See “Setting up your organizational structure” on page 19.
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To create a user manually in the Symantec Management Console

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Manage Configuration Items.

2 In the left pane, expand Organizational Types.

3 Right-click User and click Create User.

4 In the Create configuration item window, fill in the user data.

5 Click OK.

Updating your organizational hierarchy manually
When you add new locations, cost centers, or departments in the Symantec
Management Console, the items do not appear in the Organizational Views and
Groups list until the organizational hierarchy gets updated. By default, the automatic
update runs every 30 seconds and updates the organizational hierarchy.

In large environments, Symantec recommends that you disable the automatic
update task to improve the performance. You can disable it on the Organizational
Hierarchy Settings page that you access from the Settings menu, at All Settings
> Service andAsset Management > CMDBSolution >Organizational Hierarchy
Settings.

If you have disabled the automatic updating of the organizational hierarchy, you
can use the Update Organizational Hierarchy task to manually refresh the
hierarchy on demand. You can run this task immediately or on a specified schedule.
For example, you need to run the task after every import of your organizational
data.

This task is an optional step in the process for setting up your organizational
structure.

See “Setting up your organizational structure” on page 19.

To update organizational hierarchy manually

1 In the Symantec Management Console, on the Manage menu, click Jobs and
Tasks.

2 In the left pane, expand System Jobs and Tasks > Service and Asset
Management > CMDB, and then click Update Organizational Hierarchy.

3 On the Update Organizational Hierarchy page, add the organizational
hierarchies that you want to update.
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4 Click Save changes.

5 (Optional) Under Task Status, schedule the task.

For more information, click the page and then press F1.
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Managing security in Asset
Management Suite

This chapter includes the following topics:

■ Managing security on an organizational group

Managing security on an organizational group
Managing security on an organizational group involves two main steps. You assign
an organizational group to a security role, and then you set the security permissions
for the organizational group.

In most environments, you have different users who need various degrees of access
to the Asset Management Suite features. Each type of user has different access
needs. For example, a supervisor user needs the rights to verify and update resource
entries, and a manager user needs to access the reports. To set up security roles
for different types of users, you can modify the predefined asset management
security roles, or you can create new security roles.

See “Predefined asset management security roles” on page 109.

In a large and a complex organization that has offices in several countries, additional
security management might be necessary. For example, you might want to restrict
each asset management team, so that they can only view and manage the assets
for their own site. To accomplish this task, you need to create and configure
site-specific security roles.
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Table 4-1 Process for managing security on an organizational group

DescriptionActionStep

When you want to manage security of an organizational group, the first step
is to create the custom security roles. Custom security roles can help you
better manage the assets that are dispersed over multiple sites or
organizational units.

For more information, see the topics about creating and configuring a security
role in the IT Management Suite Administration Guide.

(Optional) Create a
custom security role.

Step 1

After you create a security role, you can assign an organizational group to
it. Only users who are assigned to this security role can view and manage
the assets of this organizational group.

See “Assigning an a security role to an organizational group” on page 28.

Assign an organizational
group to a security role.

Step 2

To control what a security role can do with asset records of an organizational
group, you must configure its security settings.

See “Configuring security permissions for an organizational group”
on page 29.

Configure security
permissions for an
organizational group.

Step 3

Assigning an a security role to an organizational group
Assigning a security role to an organizational group lets you specify the users who
can view and manage the assets in this organizational group. You can assign a
predefined or a custom security role. If you want to assign the a custom security
role to an organizational group, you must create the custom security role first.

For more information, see the topics about creating and configuring a security role
in the IT Management Suite Administration Guide.

This task is a step in the process for managing security on an organizational group.

See “Managing security on an organizational group” on page 27.

To assign a security role to an organizational group

1 In the Symantec Management Console, on the Manage menu, click All
Resources.

2 In the left pane, expand any organizational view, right-click an organizational
group to which you want to assign a security role, and then click Manage
Security > Assign Management Rights.

3 In the Assign Management Rights dialog box, select the security role.

4 Click OK.
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Configuring security permissions for an organizational group
Security permissions let you control the actions that the users of a security role can
perform with asset records in an organizational group.

This task is a step in the process for managing security of an organizational group.

See “Managing security on an organizational group” on page 27.

To configure security permissions for an organizational group

1 In the Symantec Management Console, on the Manage menu, click All
Resources.

2 In the left pane, expand any organizational view, right-click an organizational
group for which you want to configure the security permissions, and then click
Security.

3 On the Security Role Manager page, in the Role list, click the security role
that you want to configure.

4 Configure the security permissions.

5 Click Save changes.
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Managing configuration
items

This chapter includes the following topics:

■ Managing configuration items

■ Creating a custom configuration item type

Managing configuration items
Asset Management Suite lets you manage and track the assets that you have in
your environment. For each item that you want to manage, you enter information
into the Configuration Management Database (CMDB) as a configuration item entry.
Asset Management Suite provides you with the predefined configuration item types
that let you manages different types of assets. Configuration item types are the
templates that define the data that you can store about a specific configuration item
in the CMDB. These configuration items can be assets, locations, invoices,
schedules, users, contracts, and so on.

A configuration item type consists of the following components:

The base configuration item type is the foundation on which a configuration
item type is built. A configuration item type inherits the data classes of the
base configuration item type.

Base
configuration
item type

Data classes are the building blocks of a configuration item type. Each data
class defines the attributes that you can record about a configuration item.

Data classes

Configuration item association types create associations between configuration
items and allow related data to be linked together.

Configuration
item
association
types
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Table 5-1 Process for managing configuration items

DescriptionActionStep

Before you enter the asset data into the database,
you set up your environment for managing
configuration items. For example, you can create
custom status values and custom configuration
item types. To simplify and speed up the data entry,
you can set the default data entry values and create
custom edit views.

See “Configuring default data entry values”
on page 32.

See “Configuring ownership settings” on page 33.

See “Creating custom status values” on page 34.

See “Creating an edit view” on page 34.

See “Creating a custom configuration item type”
on page 41.

Set up the environment for managing configuration
items.

Step 1

You can create configuration items through manual
entry, scanning of the asset during the receiving
process or importing the assets. You can also
gather inventory data about the computers in your
network, and then have each computer
automatically created as a configuration item.

See “Creating a configuration item” on page 35.

After you create a configuration item, you can
manage and track it through its whole lifecycle.

Create configuration items.Step 2

You can run different asset maintenance tasks
related to asset ownership, merging of duplicate
computers or users, inventory synchronization and
network resource location.

See “Running configuration item maintenance
tasks” on page 36.

Perform configuration item maintenance tasks.Step 3

When you add cost items to an asset, you can later
use that information to determine the total cost of
ownership and chargeback.

See “Adding a cost item to an asset” on page 39.

See “About tracking the total cost of an asset”
on page 40.

Track the total cost of an asset.Step 4
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Table 5-1 Process for managing configuration items (continued)

DescriptionActionStep

You can view and track the configuration item data
through the lists, edit page, reports and Resource
Association Diagram.

You can access the configuration item reports on
the Reports page, under Reports > Service and
Asset Management > Assets.

TheResource Association Diagram lets you view
a configuration item and all its associated
configuration items. In a large environment, this
graphic makes it easier to track down an asset and
its dependencies.

See “Tracking the associations of a configuration
item” on page 41.

View and track the configuration item data.Step 5

Configuring default data entry values
The default data entry values automatically populate the fields on the configuration
item creation page and let you save data entry time. For example, if most of the
contracts in your company are assigned to the same user, you can set that user
as the default. Then you only need to change the default value when the contract
is assigned to a different user.

Note: When you import data, the default values are not applicable.

This task is a step in the process for managing configuration items.

See “Managing configuration items” on page 30.

To configure default data entry default values

1 In the Symantec Management Console, on the Settings menu, click All
Settings.

2 In the left pane, expand Service and Asset Management > CMDB Solution,
and then click Default Values.
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3 In the right pane, click the item for which you want to set the default values.

For more information, click the page and then press F1.

4 In the Data Entry default values dialog box, specify the default values, and
then click OK.

For more information, click the page and then press F1.

Configuring ownership settings
Multiple users, departments and cost centers can partly own the same configuration
item. CMDB Solution lets you assign ownership percentage to a configuration item
so that you can define the percentage that each of the multiple users, departments
or cost centers owns. To allow a configuration item to have multiple owners you
must configure ownership settings.

Ownership Settings
The following table describes the options for ownership settings:

DescriptionOption

Lets you choose whether an asset can have multiple owners. Once you
set multiple ownership, you can no longer go back to a single association.
If you set multiple ownership with warning, a warning appears when you
assign ownership to an asset that already has an owner.

Ownership
Style

Lets you specify what type of owners (users or departments) have
precedence in the event of a conflict of ownership.

Ownership
Rule

This task is a step in the process for managing configuration items.

See “Managing configuration items” on page 30.

To configure ownership settings

1 In the Symantec Management Console, on the Settings menu, click All
Settings.

2 In the left pane, expand Service and Asset Management > CMDB Solution,
and then click Ownership Settings.

3 To allow a configuration item to have multiple owners, in the right pane, under
Ownership Style, in the drop-down list, click one of the following options:

■ Multiple
Once you set multiple ownership, you can no longer go back to single
association.

■ Multiple With Warning
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Once you set multiple with warning ownership, you receive a notification
when you assign ownership to a currently owned asset.

4 To specify what type of owners to keep in the event of a conflict of ownership,
in the right pane, under Ownership Rule, in the drop-down list, click one of
the following options:

■ User Precedence

■ Department Precedence

5 Click Save changes.

Creating custom status values
For some resources, you may need to create a custom status value.

Warning: If you assign a custom status to an asset, it becomes inactive and does
not appear in the reports. Instead of using custom statuses, Symantec recommends
that you create a custom status as a Location and assign the asset to this location.

When a custom status is deleted, the resources that are configured with the particular
custom status are reverted to the Active status.

This task is a step in the process for managing configuration items.

See “Managing configuration items” on page 30.

To create custom status values

1 In the Symantec Management Console, on the Settings menu, click All
Settings.

2 In the left pane, expand Service and Asset Management > CMDB Solution,
and then click CMDB Global Settings.

3 In the right pane, in the Custom Status box, type the name of the custom
status value, and then click Add.

For more information, click the page and then press F1.

Creating an edit view
When you open the page to create or edit a configuration item, the default edit view
opens. On the default edit view, you can specify information for all the data class
attributes that apply to this configuration item type. On the default edit view, you
can also create all associations that are possible for this configuration item type. If
you do not need to insert some data or you prefer to insert the data in a different
order, you can edit the default views. You can also create new views.
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Customized edit views let you simplify and speed up the process of creating and
editing configuration items by enabling you to control which fields and options are
displayed.

Note: When you create a data class and edit a view to use in a virtual association,
the column names must be ParentResourceGuid and ChildResourceGuid to
avoid errors.

This task is a step in the process for managing configuration items.

See “Managing configuration items” on page 30.

To create an edit view

1 Open the dialog box to create or edit a configuration item.

See “Creating a configuration item” on page 35.

2 In the dialog box, in the View drop-down list, click Manage Views....

3 In the Change Edit Views dialog box, click New, insert the name of the view,
and then click OK.

4 Select the Data classes and Associations that are displayed on the Edit
configuration item page when you select the view.

Symantec suggests that you select theData classes andAssociations based
on your data entry roles.

Check Share this Edit Page View with other Asset users, if you want to
allow everyone to use this view.

5 Click Save changes.

Creating a configuration item
Configuration items represent the resources and information that you want to track
in your environment. Gathering and entering asset information is one of the first
steps in asset management. You must create a configuration item for each asset
that you want to track. To create a configuration item, you can use the predefined
configuration item types that Asset Management Suite provides. You can also create
and use custom configuration item types.

See “Predefined configuration item types” on page 110.

See “Creating a custom configuration item type” on page 41.

You can manually create configuration items or they can be automatically created.
You must manually create configuration items for non-networked assets like office
equipment, racks, and monitors. For networked devices, you can use inventory
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management tools to automate the task of creating a configuration item. For
example, you can gather inventory data about computers on your network, and
then have each computer automatically created as a configuration item.

This task is a step in the process for managing configuration items.

See “Managing configuration items” on page 30.

To manually create a configuration item

1 In the Symantec Management Console, on the Manage menu, click Assets.

2 In the left pane, expand the desired folder.

3 To create a configuration item, right-click a configuration item type, and then
click the context menu option that lets you create a new configuration item.

4 In the Create configuration item window, specify the details of the
configuration item.

5 Do one of the following:

■ Click Save and create new, to save the data and create the next item.

■ Click Apply, to save the data and continue editing the same item.

■ Click OK, to save the data and close the window.

Note that in the configuration items list, you must click Refresh to display the
changes.

To automatically create a configuration item for a network device

1 In the Symantec Management Console, on the Actions menu, click Discover
> Import Microsoft Active Directory.

2 Specify the import settings and click Save Changes.

Each identified device is set up as a configuration item in the system.

3 (Optional) To view the configuration items, in the Symantec Management
Console, on theHomemenu, clickService andAsset Management >Manage
Configuration Items, and then click the correct folder and configuration item
type.

Running configuration item maintenance tasks
CMDB Solution lets you model configuration items for any component in your
environment and the relationships between them in a centralized database. It lets
you identify all components and relationships and to instigate any required changes.
The solution actively manages configuration items according to user-specified
instructions in jobs, tasks, configuration policies, and custom CMDB rules.
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This task is a step in the process for managing configuration items.

See “Managing configuration items” on page 30.

To run configuration item maintenance tasks

1 In the Symantec Management Console, on the Manage menu, click Jobs and
Tasks.

2 In the left pane, under Jobs and Tasks, expand System Jobs and Tasks >
Service and Asset Management > CMDB, and then click one of the following
tasks:

This task lets you synchronize the owner of a computer asset
with the primary user who is reported through basic inventory.
By default, the primary user of a computer is the person who
has logged in the most during a particular month. This
information is stored in a Inv_AeX_AC_Primary_User table.

The recommended schedule is to run the task daily during
off peak hours.

Assign Computer's
Ownership to be the
Primary User

This task resolves conflicts between theAsset User Owners
resource association and the Ownership Details data class.
Ownership conflicts can occur when several departments or
users own the same resource. The Asset User Owners
resource association associates an asset with a user resource
or a department resource, and the Ownership Details data
class keeps track of the ownership percentage. If the Clean
Ownership task finds a conflict between the Asset User
Owners resource association and the Ownership Details
data class, the ownership resource association takes
precedence, and the data class is updated.

The recommended schedule is to run the task every 12 hours.

Clean Ownership
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This task automatically merges the computers that have
identical System Number, Serial Number, or Barcode in
the Configuration Management Database (CMDB).

When you use theDuplicate ComputerMerge task to merge
computers, the following restrictions apply:

■ TheDuplicate Computer Merge task only lets you merge
two computers that have duplicate system numbers, serial
numbers, or barcodes in CMDB.

■ One of the duplicate computers to be merged must be a
managed computer and the other must be an unmanaged
computer. You cannot merge two unmanaged computers.

The recommended schedule is to run the task daily during
off-peak hours.

Duplicate Computer
Merge

This task merges the users that have duplicate UserId and
Domain or Given Name and Surname information in the
CMDB.

The recommended schedule is to run the task daily during
off-peak hours.

Duplicate User Merge

This task deletes inventory data from the Asset Management
Suite inventory data classes and the Inventory Solution data
classes for the resources that are no longer in use. After
inventory data for a resource is deleted, financial and other
non-inventory data is still available.

The recommended schedule is to run the task daily during
off-peak hours.

Inventory Clean Up

This task synchronizes the following data contained in both
the Asset Management Suite data classes and the inventory
data classes:

■ Serial Number
■ System Number
■ Manufacturer
■ Model

If the task detects that the Asset Management Suite data
classes already contain data for any of these items, it does
not overwrite the data in the Asset Management Suite data
classes with the inventory data.

The recommended schedule is to run the task daily during
off-peak hours.

Inventory To Asset
Synchronization
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To merge duplicate resources for resource types other than
computers and users, you must create a merge rule with the
Resource Merge Rule task.

The recommended schedule is to run the task daily during
off-peak hours.

Resource Merge Rule

This task uses asset subnet information gathered from the
most recent inventory scan to automatically update the
location data of an asset.

The recommended schedule is to run the task daily during
off-peak hours.

The Ignore filter lets you ignore computers that have the
same IP address from a subnet.

Update Network
Resource Location

This task updates the Organizational Hierarchy groups to
match the associations in the database.

See “Updating your organizational hierarchy manually”
on page 25.

Update Organizational
Hierarchy

3 Set Default Task Parameters, if required.

4 Click Save changes.

5 In the Task Status section, click New Schedule.

6 In the New Schedule dialog box, schedule the task, and then click Schedule.

For more information, click the page and then press F1.

Adding a cost item to an asset
A cost item is an expenditure that relates to or adds to the value of an asset. For
example, you can add the cost of an extra disk drive to the value of a computer.
The additional value is added as a cost item.

This task is a step in the process for managing configuration items.

See “Managing configuration items” on page 30.

To add a cost item to an asset using the context menu

1 In the assets list, right-click an asset, and then click Asset Functions > Add
Cost Item.

2 In the Add Cost Item to Asset dialog box, specify the settings, and then click
OK.
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To add a cost item to an asset using the scheduled task

1 In the Symantec Management Console, on the Manage menu, click Jobs and
Tasks.

2 In the left pane, right-click the folder where you want to save the task, and then
click New > Task.

3 In the Create New Task dialog box, in the left pane, expand Service and
Asset Management > Asset Management, and then click Add Cost Items.

4 In the right pane, click Select a Resource.

5 In the Select a Resource dialog box, select the items to which you want to
add a cost item, click > to move the items to the Selected items list, and then
click OK.

6 In the Cost Items section, click Add to select the cost type and add a cost
item entry.

7 In dialog box that opens, enter cost item information, and then click OK.

8 Click OK.

9 On the Add Cost Items task page, under Task Status, click New Schedule.

10 In the New Schedule dialog box, configure the schedule for the task, and then
click Schedule.

For more information, click the page and then press F1.

About tracking the total cost of an asset
Asset Management Suite lets you track all the costs that occur during the lifecycle
of an asset.

On average, 25% of an asset costs come from the initial purchase and 75% of the
costs are the services and the indirect costs that arise later. Tracking the total cost
lets you keep track of all the costs that incur against an asset, a user, or an
organization.

To track the costs that are associated with an asset, you use the cost items. You
can apply the cost items to an asset manually on the Edit configuration item page,
or automatically through the procurement process or through imports.

Tracking the total cost may involve any or all of the following costs:

■ Initial purchase cost

■ Contract costs
Any contractual costs that are related to an asset are included in the total cost
of an asset. For example, the software licenses that a computer uses.
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■ Costs of the additional fixed assets or consumable items
For example, you buy a mouse for a computer or replace the toner for a printer.
The receiving feature in procurement process lets you automatically apply a
fixed asset or a consumable item as a cost item to an existing resource.

■ Maintenance, servicing, and technical support costs
You can extend cost items by customizing a workflow to apply cost items to an
asset if a certain event occurs. For example, you can apply a cost item when
an incident ticket is resolved with a particular closure code.

This task is a step in the process for managing configuration items.

See “Managing configuration items” on page 30.

Tracking the associations of a configuration item
The Resource Association Diagram displays a graphic that shows a configuration
item and all its associated configuration items. The Resource Association Diagram
lets you view relationships between assets, users, locations, departments, and cost
centers. In a large environment, this graphic makes it easier to track down an asset
and its dependencies. For example, when a technician works on an incident and
needs to review all of the details about the asset.

This task is a step in the process for managing configuration items.

See “Managing configuration items” on page 30.

To track associations of a configuration item

1 In the Symantec Management Console, on the Manage menu, click Assets.

2 In the left pane, click the desired configuration item type.

3 In the configuration items list, right-click the configuration item that you want
to track, and then click CMDB Functions > Resource Association Diagram.

4 (Optional) Adjust the Resource Association Diagram view according to your
requirements.

For more information, click the page and then press F1.

Creating a custom configuration item type
Asset Management Suite provides predefined configuration item types (also known
as resource types) for many types of assets.

See “Predefined configuration item types” on page 110.
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If the predefined configuration item types do not meet all your requirements, you
can define custom configuration item types. You can create the custom configuration
item types in the following ways:

You customize the predefined configuration item types if they do not fully meet your
requirements. For example, for some assets you might have information that cannot
be stored in the existing data classes of the predefined configuration item types. In
this situation you can define and add custom data classes and custom configuration
item association types to the predefined configuration item types.

Customize the predefined
configuration item types.

You can create new configuration item types if the predefined item types are
insufficient to represent the items in your environment. Symantec recommends that
when you create a new configuration item type, you specify a base configuration
item type for it. The new configuration item type inherits the data classes,
associations, and functionality from the base configuration item type. To extend the
definition of the base configuration item type, you add custom data classes and
custom resource association types to it.

Create new configuration item
types.

Table 5-2 Process for creating a custom configuration item type

DescriptionActionStep

When the existing data classes of a configuration
item type do not let you store all the information
that you want, you create custom data classes.

See “Creating a custom data class” on page 43.

Create a custom data class.Step 1

You create new configuration item types only when
the predefined configuration item types do no let
you manage all the resources that you have in your
environment.

See “Creating a configuration item type”
on page 44.

(Optional) Create a configuration item type.Step 2

After you create the custom data classes, you can
add them to a predefined configuration item type
or to a new configuration item type that you create.

See “Adding a custom data class to a configuration
item type” on page 45.

Add a custom data class to a configuration item
type.

Step 3

For the data types that you want to link to other
configuration item types, you create custom
association types.

See “Creating a custom configuration item
association type” on page 46.

Creating a custom configuration item association
type.

Step 4
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Table 5-2 Process for creating a custom configuration item type (continued)

DescriptionActionStep

When you create an editable data class that has
the attribute type Resource Foreign Key and
associate it with an asset, you can create a virtual
association for the asset using the data class.

See “Creating a virtual association” on page 47.

Creating a virtual associationStep 5

Creating a custom data class
Data classes are the building blocks of a configuration item type. They represent
the categories of data that you want to record about a configuration item. For
example, theComputer configuration item type contains theCost Items data class,
the Manufacturer data class, the Serial Number data class and so on.

CMDB Solution includes many predefined data classes that let you define new
configuration item types. However, if the predefined data classes are not sufficient
to clearly identify the configuration item types in your environment, you can create
custom data classes. When you create a data class, you can customize it by adding,
editing, and deleting its attributes. Note that you cannot modify or delete the
predefined data classes.

A data class can be visualized as a table in the Configuration Management Database
(CMDB). Each data class has a set of attributes that define its properties.

A data class has the following components:

Data class attributes define the data that data classes store. Data
class attributes appear as fields when you enter data. After you
add a data class attribute to a data class, you can edit certain
aspects of the attribute. You can edit the description and control
if it is hidden, but you cannot delete the description from the data
class. You cannot add data class attributes to a predefined data
class. For example, the Manufacturer data class contains the
Manufacturer Name and Model data class attributes.

Data class attribute

Data class attribute parameters specify the characteristics of a
data class attribute such as name, description, and maximum
length of the attribute. For each data class attribute, you must
specify values for each of the parameters. You can specify the
type, number, and order of characters in a field. For example, the
name to be entered into the Manufacturer Name data class
attribute might have a parameter of fewer than 256 characters.

Data class attribute
parameter
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This task is a step in the process for creating a custom configuration item type.

See “Creating a custom configuration item type” on page 41.

To create a custom data class

1 In the Symantec Management Console, on the Settings menu, click All
Settings.

2 In the left pane, expand Notification Server > Resource and Data Class
Settings > Data Classes > CMDB Data Classes, right-click the folder where
you want to create a custom data class, and then click New > Editable Data
Class.

3 On the New Editable Data Class page, give the data class a name and add
the attributes.

The name of the database table that is linked to the data class is created from
the name of this data class. It begins with the prefix Inv_ followed by the data
class name. The spaces in the data class name are replaced with the
underscore character. Note that the table name persists even if you later change
the name of the data class.

Warning: Symantec recommends that you omit special characters from the
custom data class names because they may cause errors.

For more information, click the page and then press F1.

4 Click Save changes.

After you create the data class, you can associate it with any configuration item
type. To add the data class to a configuration item type, go to Settings >
Notification Server > Resource andData Class Settings > Resource Types,
click the configuration item type where you want to add the data class, and
then in the right pane, click Add data classes.

Creating a configuration item type
Asset Management Suite provides predefined configuration item types for many
types of assets. However, sometimes the predefined configuration item types are
not sufficient and you might need to create your own configuration item types. For
example, if you want to manage your tablet computers separately from other
computers, you can create a new configuration item type for tablet computers.

This task is a step in the process for creating a custom configuration item type.

See “Creating a custom configuration item type” on page 41.
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To create a configuration item type

1 In the Symantec Management Console, on the Settings menu, click All
Settings.

2 In the left pane, expand Notification Server > Resource and Data Class
Settings > Resource Types, right-click the folder where you want to create
a custom configuration item type, and then click New > Resource Type.

3 On the New Resource Type page, give the configuration item a name and
specify its settings.

If you specify the Base Resource Type, the created configuration item type
inherits all data classes, associations, and functionality of the selected base
configuration item type. Base configuration item types let you take advantage
of built-in features such as asset aggregation, reporting, and accounting data.
Any configuration item type can serve as a base configuration item type. No
special configuration is required to allow a configuration item type to be a base
configuration item type.

4 Click Save changes.

5 (Optional) To make it easier to access the custom configuration item type,
create a link to this configuration item type in the CI Management portal.

To create the link, do the following:

■ In the Symantec Management Console, on the CI Management page, in
the left pane, right-click the folder where you want to place the link, and
then click New > Resource Type Link.

■ In the Select a Resource Type dialog box, click the custom configuration
item type, and then click OK.

Adding a custom data class to a configuration item type
After you create a custom data class, you can add it to a predefined configuration
item type or to a new configuration item type that you create.

This task is a step in the process for creating a custom configuration item type.

See “Creating a custom configuration item type” on page 41.

To add a custom data class to a configuration item type

1 In the Symantec Management Console, on the Settings menu, click All
Settings.

2 In the left pane, expand Notification Server > Resource and Data Class
Settings > Resource Types, and then click the item to which you want to add
a custom data class.
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3 On the configuration item type page, under Data Classes, click Add data
classes.

4 In the Items Selector dialog box, check the data class that you want to add,
and then click OK.

Note that once you add data into the custom data class, you cannot remove
this data class from the configuration item type anymore. You can only edit the
Edit configuration item page view so that it does not display the fields of the
custom data class.

5 Click Save changes.

Creating a custom configuration item association type
A configuration item association type (also known as a resource association type)
lets you link resources for more convenient access to associated data. You can
then easily track the data about related configuration items. A configuration item
association type is a template for creating a child to parent relationship between
configuration items. This association links child configuration items to a parent
configuration item. You can associate a computer monitor with a computer, a cell
phone with a user, and several pieces of equipment with a lease. For example, the
Power to Network Resource association type represents a group of network
resources that are directly connected to the power rather than covered by a backup
power system (UPS).

When you create a configuration item association type, a new field appears in the
child configuration item type. The field contains the list of configuration items that
the parent configuration item type defines. You can associate any of them with the
child configuration item type. For example, you can create a configuration item
association type that links the Monitor configuration item type to the Computer
configuration item type. The Monitor configuration item type includes the field with
the list of computers that you can associate with the monitor.

If the predefined associations of a configuration item type do not meet all your
requirements, you can create custom configuration item associations. For example,
you might want to associate a contract to each of your vendors as part of the contract
management. In Asset Management Suite, the default associations of a Contract
configuration item type do not let you create such an association. In this case you
can create a custom configuration item association type.

This task is a step in the process for creating a custom configuration item type.

See “Creating a custom configuration item type” on page 41.
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To create a custom configuration item association type

1 In the Symantec Management Console, on the Settings menu, click All
Settings.

2 In the left pane, expand Notification Server > Resource and Data Class
Settings > Resource Associations > CMDB Association Types, right-click
the folder where you want to create a custom association type, and then click
New > Editable Association Type.

3 On the New Editable Association Type page, give the association a name
and specify its details.

For more information, click the page and then press F1.

To create an association between a contract and a vendor, configure the details
as follows:

■ TypeContract's Vendor, as the name of the new editable association type.

■ In the Reverse Display name box, type Vendor's Contracts.

■ For the From Type configuration item type, select Contract.

■ For the To Type configuration item type, select Company.

■ In the Minimum Cardinality box, type 0.

■ In the Maximum Cardinality box, type 1.
Note that when you create a new association, you can only specify the
minimum cardinality and maximum cardinality from parent to child. The
cardinality from child to parent is always from 0 to many, and you cannot
change it.

■ Under Enable Editing From, check Contract, and in the drop-down list,
click Resource Association Picker for Asset.

4 Click Save changes.

Creating a virtual association
When you create an editable data class that has the attribute type Resource Foreign
Key and associate it with an asset, you can create a virtual association for the asset
using the data class. The virtual association is displayed as a dotted line connection
in the Resource Association Diagram.

47Managing configuration items
Creating a custom configuration item type



To create a virtual association

1 Open the CMDB SQL database and create and run the following SQL query:

create view vViewName AS

select _ResourceGuid as ParentResourceGuid, DC AS

ChildResourceGuid

from DB_Table

Where vViewName is the view name that you will use when you create virtual
association, DC is the attribute of type Resource Foreign Key, and DB_Table
is the table in the database that represents the data class you created.

Note: Ensure that the column names are ParentResourceGuid and
ChildResourceGuid to avoid errors.

2 From the Symantec Management Console, on the Settings menu, click All
Settings.

3 In the left pane, expand Notification Server > Resource and Data Class
Settings > Virtual Associations, right-clickAsset Virtual Associations, and
then click New > Virtual Association.

4 Enter the view name that you used in the SQL query and click Save. For
example, from the SQL query mentioned in Step 1, the view name is
vViewName.

5 The GUIDs ParentResourceGuid and ChildResourceGuid are displayed in
the table.

6 To see the virtual association of the asset, open the Resource Association
Diagram where the virtual association is displayed as a dotted line.

To know more about Research Association Diagram, refer to See “Tracking
the associations of a configuration item” on page 41.
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Managing contracts

This chapter includes the following topics:

■ Setting up the environment for managing contracts

■ Managing contracts

Setting up the environment for managing contracts
Before you can create contracts using Asset Management Suite, you must set up
the prerequisite configuration item types for the contracts. The Quick Start -
Contracts Web part displays the steps that must be completed in the shown order,
when you first begin managing contracts with Asset Management Suite.

See “Managing contracts” on page 52.

Table 6-1 Process for setting up the environment for managing contracts

DescriptionActionStep

An accounting period represents a yearly range of dates that correspond to
a set of financial records or reports.

See “Configuring accounting periods” on page 50.

Configure accounting
periods.

Step 1

A cost type specifies a type of expense and lets you logically group the
expenses. Cost type attributes affect depreciation values, group allocation
and other reporting areas. Asset Management Suite includes predefined
cost types, but you can add custom cost types too.

See “Creating a cost type” on page 51.

Create cost types.Step 2

The currency configuration item type lets you specify different currencies
and their rates compared to the base currency.

See “Creating a currency” on page 51.

Create currencies.Step 3
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Table 6-1 Process for setting up the environment for managing contracts
(continued)

DescriptionActionStep

After you specify the base currency, you can use the currency values and
rates with the currency convertor.

See “Configuring base currency settings” on page 52.

Configure base
currency.

Step 4

Configuring accounting periods
An accounting period represents a yearly range of dates that corresponds to a set
of financial records or reports. For example, an accounting period for a tax year
can start on June 1, and it can be divided quarterly into three-month ranges.

In Asset Management Solution, the following accounting periods are provided by
default:

■ My Book

■ My Tax

■ My Custom

The accounting period settings that you define appear in Purpose and Period in
several reports. For example, these settings appear in the Depreciation By
Assigned Cost Center report. In these reports, in the Purpose drop-down list, you
can you select an accounting period. You can then select a range of dates from
the Period drop-down list.

This task is a step in the process for setting up the environment for managing
contracts.

See “Setting up the environment for managing contracts” on page 49.

To configure accounting periods

1 In the Symantec Management Console, on the Settings menu, click All
Settings.

2 In the left pane, expand Service and Asset Management > Asset
Management Solution, and then click Accounting Periods.

3 In the right pane, configure the accounting period.

4 Click Save changes.

50Managing contracts
Setting up the environment for managing contracts



Creating a cost type
A cost type lets you specify a type of expense and logically group expenses. Cost
type attributes affect depreciation values, group allocation, and other reporting
areas. The default cost types of Asset Management Suite are contract, external
support, install, internal support, and purchase. You can also add custom cost types.

This task is a step in the process for setting up the environment for managing
contracts.

See “Setting up the environment for managing contracts” on page 49.

To create a cost type

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Contracts.

2 In theContract Management portal, in theQuick Start - ContractsWeb part,
click Cost Type.

3 In the Create configuration item window, enter the name of the cost type and
specify whether the cost is internal.

An internal cost refers to expenses within an organization. For example, an
internal cost is a cost for an employee to perform a task or the cost of a utility
that keeps systems running.

4 Click OK.

Creating a currency
If your company uses multiple currencies in its asset transactions, you can create
these currencies in your system. Currency values and rates can be used with the
currency convertor.

This task is a step in the process for setting up the environment for managing
contracts.

See “Setting up the environment for managing contracts” on page 49.

To create a currency

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Contracts.

2 In theContract Management portal, in theQuick Start - ContractsWeb part,
click Currency.
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3 In the Create configuration item window, enter the name, the standard
three-letter code and the rate of the currency.

Symantec recommends that you set the base currency rate to 1.00. You then
set other currencies to their respective exchange rates as they compare to the
base currency.

4 Click OK.

Configuring base currency settings
Before you can perform currency conversions and other finance-related operations,
you must establish a base currency.

This task is a step in the process for setting up the environment for managing
contracts.

See “Setting up the environment for managing contracts” on page 49.

To configure a base currency

1 In the Symantec Management Console, on the Settings menu, click All
Settings.

2 In the left pane, expand Service and Asset Management > Asset
Management Solution, and then click Base Currency.

3 In the right pane, add the currencies that you want to use in the system, and
then select the currency that you want to use as the base currency.

Warning: You cannot change the base currency after it has been saved.

4 Click Save changes.

Managing contracts
Contract configuration items in Asset Management Suite let you insert and track
the contract-related data in your environment. For example, you can enter details
about lease schedules, warranties and the agreements that you have signed with
your vendors or other business partners. After you create contract configuration
items, you can associate them with other items in your system. For example, you
can create a contract item that specifies the contract details, and then associate it
with a new computer purchase. This association lets you track the document-related
information for the new computer.

Before you can create and manage your contracts, you must set up your
environment.
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See “Setting up the environment for managing contracts” on page 49.

Table 6-2 Process for managing contracts

DescriptionActionStep

To track leases and contracts, you must create corresponding configuration
items in the Configuration Management Database (CMDB).

See “Creating a contract” on page 53.

Create contracts.Step 1

A contract expiration notification policy is an automation policy that sends
an email notification before a contract is due to expire. A reminder appears
before the expiration date.

See “Configuring a contract expiration notification policy” on page 55.

Configure contract
expiration notification
policies.

Step 2

You can access the contract management reports in the Symantec
Management Console, on the Reports page, under Reports > Service and
Asset Management > Contract Management.

View contract reports.Step 3

Creating a contract
To track leases and contracts, you enter the necessary data into the Configuration
Management Database (CMDB). If your contract data is stored in paper form, you
need to enter the data manually in the Symantec Management Console. If you have
your contract data available in electronic format, you can import it into the CMDB.
Symantec recommends that you use the predefined contract configuration item
types to enter your contract data.

The predefined contract configuration item types in Asset Management Suite let
you manage your contracts as follows:

A contract configuration item type lets you enter data for any type
of contract. For example, you can enter the contracts that you
have signed with your vendors.

Contract

A lease schedule lets you track lease payments, associated
resources and the duration of leases. You can set notification
policies to remind you that a lease is due to expire.

Lease Schedule
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After you create multiple lease schedules, you can combine
accounting details into a master lease for total cost of ownership
reports, generic schedule and overall summary information. A
master lease lets you quickly view summary details for all leased
equipment from one supplier. For example, you can view
payments, schedules and serial numbers for covered hardware.

For example, your organization leases several computers and
printers from the same vendor. You can then create a master lease
and link all the lease schedules that are associated with these
leased assets.

Master Lease

A non-disclosure agreement (NDA) lets you protect the sensitive
information about your organization that you share with your
business partners or contractors. An NDA configuration item type
lets you insert the NDAs that are signed for your company or the
NDAs that your company signs for the other companies.

NDA

A Service Level Agreement ( SLA) specifies the services that a
vendor or a service provider furnishes under a particular contract.

Service Level
Agreement

Warranties consist of hardware details, schedule and financial
information. The warranty contract type lets you track the
information that relates to the warranty. For example, you can
track payments, expiration date and associated serial numbers.

Warranty

This task is a step in the process for managing contracts.

See “Managing contracts” on page 52.

To create a contract

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Contracts.

2 In the left pane, under Contract Management, expand Contract Types.

3 Right-click a contract type, and then click the context menu option that lets you
create a new contract.
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4 In the Create configuration item window, specify the details of the contract.

To use the contract expiration notification feature, you must
enter the end date of the contract.

End Date

For a Lease Schedule and a Warranty, you can specify the
hardware that this contract covers.

Covered Hardware

Note that, in Asset Management Suite, you can only specify
the UNC path of the contract file. You cannot upload the
document.

Associated
Documents

5 Click OK.

Configuring a contract expiration notification policy
A contract expiration notification policy is an automation policy that sends an email
notification 30, 60, or 90 days before a contract or a software license is due to
expire.

By default, the automation policies send the notifications to the system administrator.
However, if you assign owners to the contracts, you might want the contract owner
to be notified instead.

Warning:After you configure the automation policy to send a notification to a contract
owner, you must make sure that all the contracts have an assigned owner. If a
contract does not have an assigned owner, the contract expiration notification is
not sent. To avoid this situation, you can make the system administrator the default
owner for all new contracts.

See “Configuring default data entry values” on page 32.

This task is a step in the process for managing contracts.

See “Managing contracts” on page 52.

To configure a contract expiration notification policy

1 In the Symantec Management Console, on the Manage menu, click
Automation Policies.

2 In the automation policies list, click one of the following:

■ Contracts expiring in the next 30 days

■ Contracts expiring in the next 60 days

■ Contracts expiring in the next 90 days
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3 Specify the schedule and other settings of the automation policy.

4 Under Actions, click Edit input parameter.

5 In the Edit Job/Task Input Parameters dialog box, in the To box, type the
email address of the recipient, and then click OK.

6 Click Save changes.

7 (Optional) Click Test Automation Policy.

If the automation policy works correctly, it sends an email to the email address
that you specified.

8 On the toolbar, click Turn on.

To configure a contract expiration notification policy to send an email notification
to the contract owner

1 In the Symantec Management Console, on the Manage menu, click
Automation Policies.

2 In the automation policies list, click one of the following:

■ Contracts expiring in the next 30 days

■ Contracts expiring in the next 60 days

■ Contracts expiring in the next 90 days

3 On the contract expiration notification policy page, under Details, click Edit
query.

4 In the Data Source dialog box, on the Query tab, in the left pane, click
vContract, and then, in the right pane, under Actions, click Create Joins.

5 In the Joins dialog box, do the following:

■ In the first drop-down list, leave the type LeftOuter.

■ In the second drop-down list, click vUser.

■ In the bottom left drop-down list, click [vContract].[_AssignedUserGuid].

■ In the bottom right drop-down list, click Guid.

■ Click OK.

6 In the Data Source dialog box, on the Fields tab, click Add.

7 In the Add Fields & DataClass Attributes dialog box, in the drop-down list,
click [vUser].[Email], and then click OK.

8 In the Data Source dialog box, click OK.
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9 On the contract expiration notification policy page, under Actions, click Edit
input parameter.

10 In the Edit Job/Task Input Parameters dialog box, in the To drop-down list,
click Email, and then click OK.

11 Click Save changes.

12 On the toolbar, click Turn on.
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Managing your
procurement process

This chapter includes the following topics:

■ Setting up the procurement environment

■ Performing the procurement

Setting up the procurement environment
Procurement describes the process of obtaining new objects, assets or devices for
your company. Asset Management Suite helps you manage your procurement
process and provides the templates that help you create and manage
procurement-related configuration items. Creating and using these configuration
items lets you track assets and resources for their entire lifecycle. You can also run
reports and use filters to determine the status of items in your procurement process.

TheQuick Start - ProcurementWeb part displays the steps that must be completed
in the shown order when you first begin working in the Procurement portal. First,
you must set up the stockrooms, supplier companies and catalogs, and then you
enter the catalog items. After you prepare the procurement environment, you can
create purchase requests and purchase orders.

See “Performing the procurement” on page 64.

Table 7-1 Process for setting up the procurement environment

DescriptionActionStep

Creating a stockroom is the first step of preparing the procurement
environment. A stockroom lets you keep track of the catalog items.

See “Creating a stockroom” on page 59.

Create a stockroom.Step 1
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Table 7-1 Process for setting up the procurement environment (continued)

DescriptionActionStep

Before you can create procurement catalogs, you must create company
configuration items for suppliers from whom you purchase assets and
consumables.

See “Creating a company” on page 60.

Create supplier
companies.

Step 2

Procurement catalogs store the information that you need to request assets.

See “Creating a procurement catalog” on page 61.

Create procurement
catalogs.

Step 3

After you create a procurement catalog, you must populate it with the
consumables, assets or software that users can request.

See “Adding items to the procurement catalog” on page 62.

Add items to the
procurement catalogs.

Step 4

Bundles let you group frequently ordered catalog items together.

See “Creating a bundle” on page 63.

(Optional) Create
bundles.

Step 5

The Replenish Stockroom Quantities automation policy helps you keep
track of the quantities of the consumable items in the stockroom. This policy
also performs a reorder, if necessary.

See “Replenishing stockroom quantities” on page 63.

(Optional) Keep track of
the consumable items in
stock.

Step 6

Creating a stockroom
Stockrooms are part of the procurement feature in Asset Management Suite. A
stockroom holds the assets and the consumables that are ready for distribution into
the environment. It also lets you store spare equipment until it is needed.

When you define a stockroom, you must assign it to a location and associate a user
as the stockroom manager. Before you create a stockroom, make sure that you
have the location and the manager of the stockroom defined in the Configuration
Management Database (CMDB).

At this time, a stockroom can only contain consumable configuration items. However,
you may also want to assign fixed assets to a stockroom. The best practice is to
create a location for each stockroom using the same name as the stockroom. When
you place a fixed asset in a stockroom, you then change its status to In Stock and
update its Location to reflect the stockroom. To see all fixed assets that are placed
in the stockroom, filter the Assets by Type, Status, Department, Cost Center
and Location report by Asset Status and Location parameters.

This task is a step in the process for setting up the procurement environment.

See “Setting up the procurement environment” on page 58.
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To create a stockroom

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Procurement.

2 In the left pane, right-click Stockroom, and then click Create Stockroom.

3 In the Create configuration item window, do the following:

■ Give the stockroom a name, assign it to a location and then define the
stockroom manager.
For the system to work properly, ensure that the stockroom manager has
a valid email address.

■ UnderConsumables in Stock, add the consumable catalog items that you
want to keep in this stockroom. Note that theConsumables in Stock items
must first exist in the procurement catalog and be defined as consumable
catalog items.
The consumable catalog items are generally less important assets that are
not tracked as individual resources. You only monitor the quantity of these
items in stock and order new items when the quantity becomes too low. To
make it easier to keep track of the consumable items and their quantities
in stock, you can set up notifications and automation for reordering.
See “Replenishing stockroom quantities” on page 63.

■ If you plan to use the reorder feature, specify the Stock Order Details data.

4 Click OK.

See “Creating a location” on page 21.

See “Creating a user” on page 24.

Creating a company
The Company configuration item type lets you specify data for the internal or the
external companies in the Configuration Management Database (CMDB).

For internal companies, the Company configuration item lets you create the top
level of your company's organizational hierarchy, if you have subsidiaries. If a single
company consists of multiple smaller companies, the Company configuration item
type lets you record data about these companies. If you have structured your
configuration item management system as a single company, this configuration
item type might not be needed for internal company data.

For external companies, you can use the Company configuration item type to insert
data of the companies from whom you purchase assets. In the procurement feature
of Asset Management Suite, these companies are called suppliers.
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Additionally, the Company configuration item type gets populated by the Software
Management Framework. The Software Discovery scan collects data about the
installed software and creates the software resources with the minimum metadata:
the company (vendor) name, software name and version.

Note that the Company configuration item type does not let you create a hierarchical
structure of companies.

This task is a step in the process for setting up the procurement environment.

See “Setting up the procurement environment” on page 58.

To create a company

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Procurement.

2 In the left pane, expand Organizational Types, right-click Company, and then
click Create Company.

3 In the Create configuration item window, specify the details of the company.

4 Click OK.

Creating a procurement catalog
The procurement catalog contains the information that you need to request
consumables, assets or software. The procurement catalog is directly associated
with the supplier company.

See “Creating a company” on page 60.

This task is a step in the process for setting up the procurement environment.

See “Setting up the procurement environment” on page 58.

To create a procurement catalog

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Procurement.

2 In the left pane, expand Catalogs, right-click Catalog, and then click Create
Catalog.

3 In the Create configuration item window, give the catalog a name and specify
the supplier for the catalog.

Symantec recommends that you give the catalog the same name as the supplier
company that is associated with it.

4 Click OK.
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Adding items to the procurement catalog
After you create the procurement catalog, you can populate it with the following
types of items:

You do not track consumable catalog items once you give them out.
You only track how much it costs to buy these items. For example,
consumable catalog items are cables and toners. The cost of a
consumable catalog item is charged directly from a cost center or
department. The owner of a consumable catalog item can be a cost
center or a department.

Consumable
catalog item

Fixed assets are usually purchased for a particular user. The owner of
a fixed asset catalog item can be a user or a department. For example,
fixed asset catalog items are computers, monitors, and desks.

Fixed asset
catalog item

Software is purchased for a particular user or group of users. The owner
of a Software Catalog item can be a user or a department.

Software catalog
item

Note that many suppliers provide an electronic form of their catalogs. You can use
Data Connector Solution to import these catalogs into the Configuration Management
Database (CMDB).

For more information, see the topics about managing CMDB data with Data
Connector in the IT Management Suite Administration Guide.

After you add the items to the procurement catalog, users can start requesting
purchases of these items.

This task is a step in the process for setting up the procurement environment.

See “Setting up the procurement environment” on page 58.

To add items to the procurement catalog

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Procurement.

2 In the left pane, expand Catalogs, right-click the catalog item type, and then
click the context menu option that lets you create a catalog item.

3 In the Create configuration item window, give the catalog item a name and
specify the catalog to which you want to add it.

For Fixed asset catalog item, you must also specify the Resource Type.

4 Click OK.
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Creating a bundle
Bundles let you group frequently ordered catalog items together. For example, you
can create an equipment bundle for a new tester that contains two monitors, a
desktop production computer, a keyboard, a mouse, a laptop, two test computers
and a switch box. If you need to order such set of items frequently, you can create
a bundle rather than have to select all the individual items each time you order.
Note that you can add bundles only to a purchase request.

This task is a step in the process for setting up the procurement environment.

See “Setting up the procurement environment” on page 58.

To create a bundle

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Procurement.

2 In the left pane, expand Catalogs, right-click Bundle, and then click Create
Bundle.

3 In the Create configuration item window, give the bundle a name and add
the items that you want to be part of this bundle.

Note that you must have the items inserted into the procurement catalog first.

See “Adding items to the procurement catalog” on page 62.

4 Click OK.

Replenishing stockroom quantities
You can use your stockrooms with the Replenish Stockroom Quantities
automation policy. This policy automatically keeps track of the quantities of the
consumable items in the stockroom and performs a reorder if necessary.

For each consumable item that is listed underStockOrder Details of the stockroom,
the task checks the quantity in a stockroom with the same Cost Center or
Department. If it is less than the Order Level, the policy creates a purchase order
with a quantity of Number to Order. The policy also sends an email notification to
the stockroom manager to report that the purchase order is created.

This task is a step in the process for setting up the procurement environment.

See “Setting up the procurement environment” on page 58.

To replenish stockroom quantities

1 In the Symantec Management Console, on the Manage menu, click
Automation Policies.

2 In the automation policies list, click Replenish Stockroom Quantities.
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3 On the Replenish Stockroom Quantities page, specify the schedule of the
policy and the actions that should be performed.

4 Click Save changes.

5 On the toolbar, click Turn on.

Performing the procurement
The procurement process lets you obtain new objects, assets or devices for your
company. Before you can start the procurement process, you must prepare the
procurement environment.

See “Setting up the procurement environment” on page 58.

Table 7-2 Process for performing the procurement

DescriptionActionStep

The creation of a purchase request initiates the procurement process.

You must manually create the purchase request in the Symantec
Management Console.

See “Creating a purchase request” on page 65.

Create a purchase
request.

Step 1

Symantec recommends that you use the purchase requests to generate the
purchase orders. However, you can also create a purchase order manually.

See “Generating a purchase order” on page 65.

After you create a purchase order and send it to the supplier, the procurement
process pauses until the items on the order arrive.

Generate a purchase
order.

Step 2

When a shipment arrives, you generate an invoice in the Symantec
Management Console in preparation for receiving the items. Use the purchase
order to generate the invoice.

See “Generating an invoice” on page 66.

Generate an invoice.Step 3

As the final step of the procurement process, you receive the items and place
them in the stockroom or pass them to the owner.

When you receive an item, you can specify how you want to handle it. You
can create a new resource in the Configuration Management Database
(CMDB) or you can update the existing item.

See “Receiving an item” on page 67.

Receive items.Step 4

You can access the procurement reports in the Symantec Management
Console, on the Reports page, under Reports > Service and Asset
Management > Procurement.

(Optional) View
procurement reports.

Step 5
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Creating a purchase request
To order any assets or software items, you must create a purchase request.

Warning: If you plan to create the purchase requests in the Symantec Management
Console, restrict Procurement portal permissions so that only managers or users
who have purchasing approval authority can create purchase requests. The reason
for this restriction is that the purchase request form includes a global setting that
lets you approve the request and move to the next stage in the procurement process.

This task is a step in the process for performing the procurement.

See “Performing the procurement” on page 64.

To create a purchase request in the Symantec Management Console

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Procurement.

2 In the left pane, right-click Purchase Request, and then clickCreate Purchase
Request.

3 In the Create configuration item window, specify the stockroom, requestor
and the catalog items that you want to purchase.

You must specify the quantity for each line item.

You can specify an owner for each line item separately. If you do not specify
the owner, the system automatically sets the requestor as the owner of all line
items.

For consumable catalog item types, the owner must be a Contact Center or
Department.

4 Set the Approval Status to Approved, and then click OK.

Generating a purchase order
A purchase order is a document that you send out to a supplier to order the items
that your company requires. You can generate purchase orders from the purchase
requests that you receive. You can also create purchase orders manually.

A purchase request can contain a mix of catalog item types and items from different
catalogs. For example, a purchase request can contain a Dell computer, Dell monitor,
Hewlett-Packard keyboard and mouse, Cables Direct ethernet cable, and Microsoft
Office software. When you generate a purchase order from the purchase request,
the system automatically checks the supplier of each catalog item on the purchase
request. For each different supplier company, the system creates a separate
purchase order.
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Note that before you can generate a purchase order, the Approval Status of the
purchase request must be set to Approved.

This task is a step in the process for performing the procurement.

See “Performing the procurement” on page 64.

To generate a purchase order

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Procurement.

2 In the left pane, click Purchase Request.

3 To generate a purchase order, do one of the following:

■ Open the purchase request for editing and in the Edit configuration item
window, click Generate.

■ In the right pane, right-click the purchase request, and then click Generate
Purchase Order.

When you use the Generate option in the Edit configuration item window to
generate the purchase order, you can choose to have selected line items go
across to the purchase order. If you use the right-click method, all of the line
items are processed.

Generating an invoice
When a shipment arrives, you generate an invoice in the Symantec Management
Console. Use a purchase order to generate the invoice. The invoice contains catalog
items from one supplier and is expected to be a copy of the invoice that you receive
from the supplier company. To the invoice that you generate in the Symantec
Management Console, you can attach the invoice that your supplier sends.

This task is a step in the process for performing the procurement.

See “Performing the procurement” on page 64.

To generate an invoice

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Procurement.

2 In the left pane, click Purchase Order.

3 To generate an invoice, do one of the following:

■ Open the purchase order for editing and, in the Edit configuration item
window, click Generate.

■ In the right pane, right-click the purchase order, and then click Generate
Invoice.
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When you use the Generate option in the Edit configuration item window to
generate the invoice, you can choose to have selected line items go across to
the invoice. If you use the right-click method, all of the line items are processed.

Receiving an item
As the final step of the procurement process, you receive the catalog items and
place them in the stockroom or pass them to the owner. The system automatically
creates a receiving slip to record the receiving action.

To accommodate different workflows, you can receive items from a purchase
request, purchase order or invoice. Note that if you receive items from a purchase
request, you must split up any bundles into their individual catalog items.

When you receive an item, you can specify whether you want to create a new
resource for this item or update the existing catalog item. The receiving process
handles each type of catalog item differently:

When you receive a consumable catalog item, the system creates a
new consumable catalog item or increases its quantity in the stockroom.
You do not track consumable catalog items once you give them out.

Consumable
catalog item

When you receive a fixed asset catalog item, the system creates a new
resource in the Configuration Management Database (CMDB) or
updates an existing asset. You can track the fixed asset catalog item
for its entire lifecycle.

Fixed asset
catalog item

When you receive a software catalog item, it becomes a software
purchase configuration item in the CMDB.

Software catalog
item

This task is a step in the process for performing the procurement.

See “Performing the procurement” on page 64.

To receive an item

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Procurement.

2 In the left pane click Invoice.

Note: If Invoice has not been generated, you can receive items from Purchase
Order. If Purchase Order has not been generated, you can receive items from
Purchase Request.

3 In the right pane, right-click the invoice, purchase order or purchase request,
and then click Receive Items.
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4 In the Receive Items dialog box, specify the stockroom where you want to
place the items.

For more information, click the page and then press F1.

See “Receive Items page” on page 115.

5 Click Receive.
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Managing software licenses

This chapter includes the following topics:

■ Managing your software license compliance using the Software view

■ Managing your software license compliance on the Asset Management Solution
pages

Managing your software license compliance using the
Software view

Asset Management Suite lets you optimize the usage of licensed software in your
environment by comparing the number of the software product installations to the
number of purchased licenses and the terms of the license contract that you
configure. You can stay compliant with the purchased software licenses and at the
same time improve software availability by optimizing usage of existing licenses.
You can plan your future software purchases more accurately. You can also use
this functionality during software audits.

To set up software license compliance, you must first collect data about the software
that is installed on your client computers. After you discover the software, you add
information about the purchased licenses to tie together the software product
information and the number of purchased licenses.

If you have Asset Management Suite and Client Management Suite or IT
Management Suite installed, you can manage your software licenses using the
Software view from Symantec Management Console. If you have Asset Management
Suite, you can use Asset Management Solution pages to manage your software
licenses.
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Note: If you only install Asset Management Suite, the Software view is not installed.
The Software view is only available when you install IT Management Suite or Client
Management Suite.

The Software view lets you manage software licenses in your environment with a
few easy steps.

Note that the process of managing your software license compliance using the
Software view from the Symantec Management Console provides more options
than the Asset Management Solution pages. For example, you can manage license
compliance with a few easy steps while considering software usage and create
custom reports in a single click.

For more information, see the topics about the Software view in the IT Management
Suite Administration Guide.

See “Managing your software license compliance on the Asset Management Solution
pages” on page 86.

Table 8-1 Process for managing your software license compliance using the
Software view

DescriptionActionStep

Software inventory collects information about the applications that are
installed on your client computers. To gather software inventory, you must
have Inventory Solution installed on your Notification Server and the Inventory
plug-in installed on your client computers.

See “Methods for gathering software inventory” on page 71.

For more information, see the topics about gathering your software inventory
in the Inventory Solution User Guide.

Gather software
inventory.

Step 1

To create a licensed software product, you identify the filter rules that define
the software product and specify the software license data.

See “About creating a software product item using the Software view”
on page 73.

Create a licensed
software product.

Step 2

A software license item ties together the software purchase and the software
product.

See “Software Product dialog box” on page 74.

Creating a software
license

Step 3

Edit the license rules parameters. For example, license types, authorized
filters, etc.

See “Edit License Rule dialog box” on page 77.

(Optional) Edit the
license rules.

Step 4
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Table 8-1 Process for managing your software license compliance using the
Software view (continued)

DescriptionActionStep

After you set up your environment, you can track the software license
compliance.

See “Viewing license information in ITMS Management Views” on page 78.

Viewing license
information in ITMS
Management Views

Step 5

Based on the software license compliance information you can create a
custom report with a few easy steps.

See “Filter/Target Results Report dialog box” on page 84.

(Optional) Create
custom report for license
compliance tracking

Step 6

Methods for gathering software inventory
You can gather inventory about the software applications that are installed in your
environment. For example, you can gather information about the application version,
build number, and manufacturer.

Note: If a manufacturer does not provide the version of the software, a version is
not populated for the relevant software component.

When you perform a software inventory, you can use different methods to gather
different types of data.
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Table 8-2 Methods for gathering software inventory

DescriptionMethod

This software inventory method scans the file system on managed computers and
reports software inventory based on the software application .EXE files that are found.
For example, it reports file name, size, path, and so on.

In addition to the file properties, the information about the key executables for the
installed applications is collected as follows:

■ For each user, the inventory agent scans the Start Menu folder for .lnk files and
collects the information about where the links point to.

■ For each user, the inventory agent scans the registry for the installed MSIs, and
then each MSI is scanned for the included binaries that have a corresponding .lnk
item in the MSI database.

To gather basic software application file inventory on managed Windows and UNIX,
Linux, and Mac computers, you create, configure, and turn on the inventory policy with
the File Properties - manufacturer, version, size, internal name, etc. box checked.

To gather basic standalone inventory on unmanaged Windows computers, you create,
configure, and run the stand-alone inventory package with the File Properties -
manufacturer, version, size, internal name, etc. box checked.

Beside collecting file properties based on inventory rules, inventory agent collects
information about key executables for installed applications: 1) For each user scan
Start Menu folder for .lnk files and collect information about executables where link
points to 2) For each user scan registry for installed MSIs and each found MSI scan
for included binaries that have corresponding .lnk item in MSI database. Collect
information about these executables.

Basic software application file
inventory

This software inventory method uses the Software Discovery task to collect the
information about the installed software applications.

On Windows computers, you can gather information about the applications that are in
the Add or Remove Programs list of managed computers (MSI cache). Note that
when Inventory Solution is installed, it turns off any schedules for the Software
Discovery task. Instead, it uses the schedules of the Inventory policies that use it.

On UNIX, Linux, and Mac computers, you can gather information about the software
packages on managed computers.

To use this method on managed Windows, UNIX, Linux, and Mac computers, you
create, configure, and turn on the inventory policy with the Software – Windows
Add/Remove Programs and UNIX/Linux/Mac software packages box checked.
This box is checked by default.

To use this method on unmanaged Windows computers, you create, configure, and
run the stand-alone inventory package with the Software – Windows Add/Remove
Programs box checked.

Inventory of WindowsAdd or
Remove Programs list and
UNIX/Linux/Mac software
packages
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Table 8-2 Methods for gathering software inventory (continued)

DescriptionMethod

On managed Windows computers, this software inventory method lets you use rules
to identify specific software applications.

To use this method, you run the Targeted Software Inventory policy.

On managed UNIX, Linux, and Mac computers, this method lets you collect information
about the installed software applications using the filescan.rule file. The software
inventory agent compares a list of applications in the filescan.rule file with the
actual file system data to determine which applications are installed.

Targeted software inventory
on Windows computers

Software inventory using the
filescan.rule file on
UNIX, Linux, and Mac
computers

The Software Catalog Data Provider is a component of Inventory Solution that can be
used to import software inventory data into the Software Catalog. The Software Catalog
Data Provider is installed with Inventory Solution.

The Software Catalog Data Provider provides a list of known software applications and
predefined software products that is imported in the Configuration Management
Database (CMDB). When you perform software inventory, the gathered data about
software applications can be compared to the list of known applications and predefined
software products. If the application data matches, it helps ensure that your software
inventory data is accurate and lets you manage installed software at the product level.

Gathering software
information and validating it
using the Software Catalog
Data Provider

(Windows only)

About creating a software product item using the Software view
Software product items let you manage the details that are related to the software
products and their different versions in your environment.

You can create a single software product item and associate it with several different
versions of the same software. For example, you can associate both Norton Ghost
15.2 and Norton Ghost 15.3 SP2 with a software product item Norton Ghost 15.
When these different versions are reported, they are consolidated for the software
product named Norton Ghost 15.

When you create a software product item, you specify its name, description,
company, and category. After you create a software product, you make associations
between the software product, a software resource (also called a software
component), and a software license. Creating these associations lets you identify
how many copies of a given software product you have in your environment. You
can compare the number of copies with the number of the software licenses that
you own.

This task is a step in the process for managing your software license compliance
using the Software view.

See “Software Product dialog box” on page 74.
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Software Product dialog box
To access the Software Product dialog box, do one of the following:

■ On the Software view page, in the content pane, right-click a managed software
product, click Configure, and then click one of the actions in the menu
(Component association, Usage tracking, Software delivery or Licenses).

■ On theSoftware view page, in the content pane, right-click a software component
from the Discovered Unreviewed Software folder, and then, in the Software
Component Summary flipbook, click Create a software product symbol.

■ In the Software Catalog dialog box, right-click a software product in the
Managed software products or a software component in the Unmanaged
software folder. Click Configure, and then click an option in the right-click menu
(Component association, Usage tracking, Software delivery or Licenses).

In theSoftware Product dialog box, you can review the information about a software
product and configure the settings for this product.

You can do the following:

■ Modify the product's filter criteria to identify the software to associate with this
product.

■ Meter and track the usage of the product.

■ Choose the software packages to deliver.

■ Track software usage or add and manage the purchased licenses.
See “Software Product Summary flipbook” on page 79.

Note: To change the icon for a software product, click the Change... symbol in the
upper right corner of the dialog box. Note that only PNG and JPG image formats
are supported.
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Table 8-3 Tabs on the Software Product dialog box

DescriptionTab

Shows the non-hidden software components that are associated with the software
product and match the search criteria.

You can view and modify the filtering rules that define the product.

Filtering rules are dynamic. Any software that comes into your environment that matches
these rules is automatically associated with this product.

The filtering criteria are as follows:

■ Software name
■ Company
■ Version
■ Installs

This column shows the number of client computers on which the software is found.
Because more than one software component can be installed on a client computer,
the number that is shown in the Installed column may not correspond to the number
of used licenses that is shown for the installed products in the Software Product
Summary flipbook.

When you change the software product name, for example, from Adobe Reader to
Adobe, the data on the tab changes to display the information about all Adobe
components.

To activate the Company filter, you must first enter the value for the Software name
filter.

If you check the Include components associated with other products box, the
software list will include the components that you can associate with the software
product but that are currently associated with another software product. The components
that are associated with another product are highlighted. When you click the highlighted
component, you can change the software association or keep the current software
association.

Note that, if the query returns too many results, these results are never fully loaded
and the process gets stuck. To make the search more specific and avoid this issue,
use the Search as you type option.

Identify inventory
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Table 8-3 Tabs on the Software Product dialog box (continued)

DescriptionTab

Shows the following data:

■ All the software components that are associated with the software product.
■ All manually imported software components that are associated with the software

product.
■ All manually created associations between the software product and the software

components.

You can meter and track the usage of a software product.

You can only meter and track a software product if it has at least one program that is
associated with it.

If no program is associated with the software product, in the Programs list, click Add
Program, and then, in the Add Program dialog box, choose the program that you
want to associate with the software product.

To enable software metering and tracking, check the Turn onmetering/usage tracking
for this software product box.

If the product has not run on your computer for 90 days, the product is considered
unused by default. You can change the default number of days at the bottom of the
tab.

Meter / track usage

You can select software packages to deliver.

The Delivery tab displays available software packages. If only one package is
associated with the product, the package is automatically selected as the package to
be delivered. If only one command line is associated with the package, the command
line is automatically selected as the command line for the package.

If more than one package is associated with the software product, you can select the
default package to be used when the product is delivered. If more than one command
line is associated with the package, you can select the default command line to be
used for the package.

Note that if you select a different default package to associate with the product, it
becomes the new default package. If you select a different default command line to
associate with the package, it becomes the new default command line for the package.

If no packages are displayed on the Delivery tab, click Import to define a package.
You can also add a software package or a command line, edit, or delete a software
package or a command line.

Delivery

76Managing software licenses
Managing your software license compliance using the Software view



Table 8-3 Tabs on the Software Product dialog box (continued)

DescriptionTab

You can manage your software licenses.

If you check the Licensable product box, you can license software products, add
purchases to a license, create new licenses, and edit or delete software purchases
and licenses. By default, this box is checked.

The table shows you all the license contracts that are related to this software product.
Expired contracts are marked in red, and the contracts that will be active in future are
greyed out.

When you click Add license, in a dialog box that opens, you can edit the product
license information and add or delete purchases.

Note: To manage software licenses, you must have the Asset Management Suite
installed.

For more information, see the topics about installing Asset Management Suite in the
ITMS Management Suite Planning and Implementation Guide and the topic about
managing software licenses in the Asset Management Suite User Guide.

Licenses

Edit License Rule dialog box
In this dialog box, you can choose the rule according to which license usage is
calculated.

Additional options become available depending on the type of rule that you choose.

In the Edit License Rule dialog box, in the Type drop-down list, you can select the
following types of license rules:

Table 8-4 Types of license rules

DescriptionType

This rule lets you specify a list of devices on which the
software product can be installed and used.

The license usage for devices that do not belong to this filter
is counted as unauthorized. If you do not select a filter, the
license usage is counted as authorized for all devices and
on Notification Server.

Per Device
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Table 8-4 Types of license rules (continued)

DescriptionType

This rule lets you specify a list of devices on which the
software product can be installed, a list of users that can run
this software product, and the limit for installations.

The license usage for devices and users that are not in the
filter is counted as unauthorized. If you do not select a filter,
the license usage is counted as authorized for all devices
and users on Notification Server.

Per User

This rule type lets you specify a list of devices and the number
of processors or cores that is used to calculate the license
usage.

The licenses are counted according to the use of physical
processors or cores, and the Point Value coefficient.

Per Processor/Core

See “Software Product Summary flipbook” on page 79.

Viewing license information in ITMS Management Views
In ITMS Management Views, you can see the information about your software
products and licenses in the Software Product Summary flipbook.

See “Software Product Summary flipbook” on page 79.

To view license information in ITMS Management Views

1 In the Symantec Management Console, on theManagemenu, click Software.

2 In the left pane, under Software Filters, click the filter that contains the
managed software product (for example, Installed Products or All Software).
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3 In the content pane, click any installed software product, and then, in the right
pane, in the Software Product Summary flipbook, you can see the information
about software usage or license usage and compliance.

For a licensed software product, the color-coded License Utilization pie chart
shows you how many licenses there are, how they are utilized and if any of
them are used without authorization.

See “License Utilization pie chart” on page 81.

For an unlicensed software products, the color-coded softwareSoftware Usage
pie chart shows you how many software products are used, unused or
untracked.

See “Software Usage pie chart” on page 82.

4 (Optional) To filter the Computers with software installed list according to a
specific license software or license state, click a section in the pie chart.

You can save the computer list as an editable filter or a report.

See “Computers with software installed list” on page 83.

Software Product Summary flipbook
In the Software Product Summary flipbook, on the Software View page, you can
see detailed information about software and license usage on your client computers.
You can use this data to create reports and filters and manage your licensed
software.

The flipbook is available for all software products.

The Software Product summary contains the following sections:
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Table 8-5 Software Product Summary flipbook sections

DescriptionSection

The product status can be as follows:

■ Compliant
■ Needs Attention

This status indicates that there are problems with
current license utilization. This status is typically
displayed when there are underutilized licenses.

■ Action Required
This status indicates that there are serious problems
with current license utilization that require immediate
actions. This status is typically displayed when there
are overutilized licenses.

For more information and a suggestion of further actions,
click the product status.

Overall status of the software product.

Shows the following information about a software product:

■ General information about the product (name,
company, version).

■ State (Managed or Unmanaged).
To make the product managed or unmanaged, in the
content pane, right-click the product, and then, in the
drop-down menu, click the option that you need.

■ Usage tracking (On or Off)
■ License type

The type of rule according to which license usage is
calculated (per device, per user or per processor/core).
You select the rule when you create or edit a software
license.
If the software is unlicensed, there is a link to the
Licenses tab on the Software Product page. From
this tab, you can add licenses to your software product.
See “Creating a software license” on page 89.

■ The number of active licenses.
(For a licensed product)

■ Average license price.
(For a licensed product)

General information about the software product.

A color-coded chart that describes software and license
usage.

See “License Utilization pie chart” on page 81.

(For a licensed product)

License Utilization pie chart
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Table 8-5 Software Product Summary flipbook sections (continued)

DescriptionSection

A color-coded chart that describes software usage.

See “Software Usage pie chart” on page 82.

(For a non-licensed product)

Software Usage pie chart

You can filter the results in this dynamic list according to
the particular state of software or license usage and save
the results as an editable filter or report.

See “Computers with software installed list” on page 83.

Computers with software installed

From this list, you can open the policy page to view or
configure the policy settings.

Policies installing this software

See “Viewing license information in ITMS Management Views” on page 78.

License Utilization pie chart
The color-coded License Utilization pie chart is shown for a licensed software
product on the Software Product Summary flipbook.

The pie chart consists of two circles:

■ An outer circle that shows the license utilization summary.
See Table 8-6 on page 81.

■ An inner circle that shows detailed information about license usage.
You can click the sections of this circle to filter the Computers with this
software installed list.
See Table 8-7 on page 82.

The chart shows the following information about the usage of software licenses:

Table 8-6 Information under Summary

DescriptionStatus

The number of licenses that are not consumed or licenses
belonging to software that is installed but not used. Potential
savings are shown based on the average license price.

Note that, if software usage tracking is turned on and the
software is unused, the license is counted as Underutilized.

Underutilized

The number of licenses that are used in a normal way.

Note that, software usage tracking is turned off, the license
for installed software is always counted as Utilized.

Utilized
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Table 8-6 Information under Summary (continued)

DescriptionStatus

The number of licenses the usage of which exceeds the
number of purchased licenses or that were installed without
authorization.

Overutilized

Table 8-7 Information under License Usage

DescriptionStatus

The number of available licenses that are not consumed.Available

The number of licenses belonging to unused software
products that were discovered during software inventory.

Unused

The number of licenses used by software products on
inventoried client computers for which usage tracking and
metering is turned on.

Used

The number of consumed licenses on the non-inventoried
client computers. This number is entered by the administrator
in the license editor.

Tracked manually

The number of consumed licenses that were discovered by
Inventory on the client computers on which the software
usage is not tracked.

No tracking data

The number of licenses for software found on client
computers that do not belong to a defined computer or user
filter.

Unauthorized

See “Software Product Summary flipbook” on page 79.

Software Usage pie chart
The color-coded Software Usage chart is shown for an unlicensed software product
on the Software Product Summary flipbook.

The pie chart shows the following information:

Table 8-8 Software Usage data

DescriptionStatus

The number of client computers on which the software
product was not reported by metering as used during last 90
days (default number).

Unused
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Table 8-8 Software Usage data (continued)

DescriptionStatus

The number of client computers on which the software
product was reported by metering as used during last 90
days (default number).

Used

The number of client computers on which the software
product is reported as installed, but there is no metering
information about the software usage.

This happens, for example, if usage tracking for a software
product is turned off, if the computers on which this software
is installed are not targeted by the software usage tracking
or metering policy, or if software tracking is not supported by
the operating system on this client computer.

For untracked software products, the User column in the
Computers with software installed list shows the primary
user of the client computer.

Untracked

See “Software Product Summary flipbook” on page 79.

Computers with software installed list
In theComputers with software installed list on the Software Product Summary
flipbook, you can do the following:

■ Filter the data according to the state of license usage.
To filter the computer list, on the License Utilization pie chart, click a section
in the inner circle or a license state under License Usage.
You can also click Filter by Usage on the toolbar, and then check or uncheck
the boxes.
To restore the default filter settings, click Default. To enable all filtering options,
click Select all

■ Create a computer filter.
You can save the computer list as a filter, and then edit this filter and use it for
managing software.

■ Create a report.
You can save the computer list as a dynamic editable report.

The list contains the following columns:
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Table 8-9 Columns in the computer list

DescriptionColumn

This column shows the name of the client computer on which
the software product is installed.

If license utilization count is based on users that use the
software product (Per User license rule type), the same client
computer may be shown multiple times, but each entry shows
a different user.

See “Edit License Rule dialog box” on page 77.

To see the computer properties in the Computers view, click
the computer name.

Computers

If the software product is untracked and there is no
information about software usage, this column shows the
primary user of the client computer.

If software usage metering for the product is turned on, this
column shows the user of the client computer based on the
data gathered by metering scan.

User

This column is shown only for licensed software products.

This column shows the information about license usage.
Depending on the license rule type, the license usage is
counted differently.

License Usage

This column shows the information about the usage of the
software products by a particular user on a particular client
computer.

Software Usage

This column shows the date when the software product was
last used on the client computer.

Last Used

This column shows the date when the software product was
installed on the client computer.

Installed Date

See “Software Product Summary flipbook” on page 79.

Filter/Target Results Report dialog box
In the Filter/Target Results Report dialog box, you can configure a detailed report
for a computer filter, target or a software filter.

To open the dialog box, right-click a computer filter, a target or a software filter, and
then clickViewResults Report. Also, when you are viewing computer filter, software
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filter or target details, at the top of the content pane, you can click the View
filter/target results report symbol.

In the Filter/Target Results Report dialog box, you can see the following sections:

Table 8-10 Sections in the Filter/Target Results Report dialog box

DescriptionSection

In this section, you can choose associations,
data classes and columns or views for
reporting.

To save the report configuration for the
selected filter or target, at the bottom of the
dialog box, check Save the selected
columns for filter/target. The configuration
is saved separately for each user and each
filter or target.

Select columns for report

In this section, you can see the results
depending on the items that you chose in the
left section. By default, this dialog box shows
the data based on the filter or target that you
opened it from. The columns shown by default
are the selected filter or target criteria.

The columns may return multiple results. If
you use the Search box, all the returned
results are scanned.

You can select one or multiple items, and
then copy and paste the report results to a
text file.

You can move and reorder the columns. The
only exception is the column Name, which
cannot be moved.

Report results view

You can export the report results as a CSV file. To do that, at the bottom of the
Filter/Target Results Report dialog box, click Export. In the Dialog box that opens,
type the name for the file, choose the location to save the file to, and then click
Save.

If the report is created from a Query Builder filter, in the Save as Report dialog
box, you can choose to save the report to the legacy ITMS reports tree. Then, you
can navigate to the saved report, right-click the report, and then click View as XML.
In the right pane, you can edit the query and save the changes.
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To open the report at once, check the Open report in new window after saving
box.

Managing your software license compliance on the
Asset Management Solution pages

The following information is useful if you have installed only Asset Management
Suite.

Asset Management Suite lets you audit software license compliance by comparing
the number of the software product installs to the amount of purchased licenses
and the terms of the license contract.

Managing the software licenses in your environment lets you easily report software
license compliance for software audits. It minimizes the risk that software installs
exceed the amount of software licenses. Software license compliance reports let
you plan your future software purchases more accurately.

To set up software license compliance, you must first collect data about the software
that is installed on your client computers. After you discover the software, you insert
information about the purchased licenses. Software license items let you tie together
the software product information and the amount of purchased licenses.

If you have Asset Management Suite and Client Management Suite or IT
Management Suite installed, you can manage your software licenses using the
Software view in the Symantec Management Console. If you do not have Client
Management Suite or IT Management Suite installed, you can use Asset
Management Solution pages to manage your software licenses.

To track and manage software license compliance using the Asset Management
Solution pages, you must insert the software-related configuration items and create
the necessary associations.

Table 8-11 Process for managing your software license compliance on the Asset
Management Solution pages

DescriptionActionStep

Software inventory collects information about the applications that are
installed on your client computers. To gather software inventory, you must
have the Inventory Solution installed on your Notification Server and the
Inventory plug-in installed on your client computers.

For more information, see the topics about gathering your software inventory
in the Inventory Solution User Guide.

See “Methods for gathering software inventory” on page 71.

Gather software
inventory.

Step 1
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Table 8-11 Process for managing your software license compliance on the Asset
Management Solution pages (continued)

DescriptionActionStep

A software product item contains information about the software.

After you create the software product item, you associate it to the software
resource and to the software license information.

See “Creating a software product item” on page 87.

Create software product
item.

Step 2

Before you can view the reports, you must configure the software resource.
You must associate a software product item to the software resource.

See “Associating a software product item to a software resource” on page 88.

Create or configure
software resource.

Step 3

A software license item ties together the software purchase and the software
product.

See “Creating a software license” on page 89.

Creating a software
license

Step 4

Edit the license rules parameters. For example, license types, authorized
filters, etc.

See “Editing the license rules” on page 90.

(Optional) Edit the
license rules.

Step 5

After you set up your environment, you can track the software license
compliance.

See “Tracking the software license compliance” on page 93.

Note: This functionality will remain compatible with the old license engine
for some time, but is no longer supported or developed, and could be
removed in the future.

Track software license
compliance.

Step 6

You can upgrade or renew the software license.

See “Upgrading and renewing a software license” on page 95.

(Optional) Upgrade or
renew software license.

Step 7

Creating a software product item
Software product items let you manage the details that are related to the software
products and their different versions in your environment.

You can create a single software product item and associate it with several different
versions of the same software. For example, you can associate both Norton Ghost
15.2 and Norton Ghost 15.3 SP2 with a software product item Norton Ghost 15.
When these different versions are reported, they are consolidated for the software
product named Norton Ghost 15.
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When you create a software product item, you specify its name, description,
company, and category. After you create a software product, you make associations
between the software product, a software resource (also called a software
component), and a software license. Creating these associations lets you identify
how many copies of a given software product you have in your environment. You
can compare the number of copies with the number of the software licenses that
you own.

This task is a step in the process for managing your software license compliance.

See “Managing your software license compliance on the Asset Management Solution
pages” on page 86.

To create a software product item if have installed only Asset Management Suite

1 In the Symantec Management Console, on theManagemenu, click Software.

2 In the left pane, under Software Catalog, click Software Product.

3 On the Software Product page, click Add.

4 In the Add or Edit Product dialog box, specify the details of the software
product, and then click OK.

Note: This option is not available if you have Asset Management Suite and Client
Management Suite or IT Management Suite installed. In this case, you must manage
software license compliance through the Software view.

See “Managing your software license compliance using the Software view”
on page 69.

Associating a software product item to a software resource
A software resource represents a common way to describe a specific instance of
a software application so that all software-related actions can identify it accurately.
For example, a software resource is Asset Management Solution 7.0.1341.0 English.

You create a software resource for the software that you want to manage. For
example, you can create a software resource for the software that is installed on
client computers in your network.

For more information, see the topics about software resources in the IT Management
Suite Administration Guide.

To make the software license compliance work, you must associate a software
product item to a software resource. A software product item can have one or
multiple software resources linked to it.
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This task is a step in the process for managing your software license compliance
on the Asset Management Solution pages.

See “Managing your software license compliance on the Asset Management Solution
pages” on page 86.

To manually associate a software product item to a software resource

1 Open the software resource for editing.

■ In the Symantec Management Console, on the Manage menu, click
Software.

■ In the left pane, under Software Catalog, click Installed Software and
open the software resource for editing.

For more information, see the topics about editing software resources in the
IT Management Suite Administration Guide.

2 On the software resource page, on theProperties tab, in theSoftware Product
drop-down list, click the software product that you want to link to the software
resource.

Note: This option is not available if you have Asset Management Suite and
Client Management Suite or IT Management Suite installed. In this case, you
must manage software license compliance through the Software view.

See “Managing your software license compliance using the Software view”
on page 69.

3 Click OK.

Creating a software license
Use this dialog box to create a license contract. You can add information about the
license contracts and the license purchases.

To open the Creating Software License dialog box:

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Software Licensing.

2 In the left navigation pane, right-click Software License, and then clickCreate
Software License.

3 Add the required software product in the Select Software Product dialog box.
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4 In the Create Software License dialog box, enter the required information.

DescriptionOption

By default this field displays the selected product name.Name

Use this option to define the licensing rule. By default,
New Rule is displayed with Type: Per Device. Click
New Rule (License rule name) to modify the licensing
rule.

Note: A single software product can have only one
license rule at a time

For more information, See “Editing the license rules”
on page 90.

License Rule

Date when the licensing contract begins.Start Date

Date when the licensing contract expires.

Note: Leave this field empty for software the products
that have licenses without any expiration date.

Expiry Date

Enter additional comments about the software license.Comment

Add the details about the license purchase order. After
you enter the information about the licensing contract,
one row gets added with default values.

You can add more purchase orders for a licensing
contract. You can edit the field values by double-clicking
the cell under a column.

Purchases

Use this option to open the Advanced View dialog box
after you click Save.

Advanced View dialog box lets you define additional
parameters for licensing contract and purchase.

Edit advanced settings after
saving

5 Click Save to create the software license resource.

To view software license information from the ITMS Management Views, See
“Viewing license information in ITMS Management Views” on page 78.

Editing the license rules
You can edit the license rule while creating the software license or by editing the
existing software license resource. Every license rule provides a set of configurable
parameters that help to calculate the license consumption.
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The three main base types that can be applied to the license rules are:

■ Per Device
Specify the devices for installing a software product. Use this option if your
licenses are consumed as per the number of installations. In this case one
installation consumes one license.
The configurable parameter forPer Device base type is theAuthorized Devices
filter. Use the Click to select… option to open the Select tree item dialog box
for selecting an existing or customized filter.

Note: All installations on the devices that are not included in the defined filter
are considered as Unauthorized. If a filter is not selected, then all the
installations are considered as Authorized.

■ Per User
Specify the devices for installing the software and the users that can use the
installed software. Use this option if your license is consumed for every user
installing the software on one or more than one device.
The configurable parameters for Per User base type are:

■ Authorized Devices
Use the Click to select… option to open the Select tree item dialog box
for selecting an existing or customized filter.

Note: If Per User license type is selected and the software is installed and
used on a non-specified device, then the installation is considered as an
Unauthorized.

■ Authorized Users
Use the Click to select… option to open the Select tree item dialog box
for selecting an existing or customized filter.

Note: If Per User license type is selected and the software is installed and
used on a non-specified user, then the installation is considered as an
Unauthorized. If filters are not selected, then all the installations for all of
the users are considered as Authorized.

■ Installations per user (by default this value is 1)
Define the number of software installations per the user that count as one
license (as per the license agreement).
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For example, if you set the value as 10, then a specified user can install the
software on up to 10 selected devices and the installations consume one
license. If the installations exceed this value, then more than one license
gets consumed. From 11 to 20 installations, 2 licenses are consumed and
from 21 to 30 installations, 3 licenses are consumed.

Note: If the Installations per user option is not selected, then all the
installations per user in consumes one single license. For example, if there
is 1 software installation per user, 1 license is consumed, or if there are 15
installations per user, even then 1 license is consumed.

■ Per Processor/Core
Specify the license consumption calculated as per processor or per core. Use
this option if your license consumption is calculated per processor or per core.
The configurable parameters for Per Processor/Core base type are:

■ Calculation
Select either Per Processor or Per Core as the base for making calculations
for license consumption.

■ Affinity Adjustment table
Define the device name, affinity, and point value for calculating the
consumption of licenses.
The number of licenses consumed by a single device is the multiplication of
the Affinity number of Processors/Cores and the point value.

Note:Non-specified devices are considered asUnauthorized and installation
of the software on Unauthorized devices is termed as unauthorized usage.

For the calculation of licenses consumed by Unauthorized devices, point
value is taken as the maximum of the entered point values and affinity is
taken from the inventory information for each device.
Use the Add Device option to select and add devices.
As you make changes, the Entered By and Entered Date information is filled.

For more information, See “Creating a software license” on page 89.

To edit an existing software license:

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Software Licensing.

2 In the right-side pane, right-click the existing software license and select Edit.
The Advanced View dialog box opens.
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3 Click the License Rule option to open the Edit License Rule dialog box.

4 In the Edit License Rule dialog box, enter the required information.

DescriptionOption

Enter the name for the license rule.Name

Defines the base type for the license rule.Type

Specify the devices for installing a software
product. Use this option if your licenses are
consumed as per the number of installations. In
this case one installation consumes one license.

Type: Per Device

Specify the devices for installing the software and
the users that can use the installed software. Use
this option if your license is consumed for every
user installing the software on one or more than
one device.

Type: Per User

Specify the license consumption calculated as per
processor or per core. Use this option if your
license consumption is calculated per processor
or per core.

Type: Per Processor/Core

5 Click OK to continue creating the software license resource.

6 To apply the license rule changes, click Yes.

Warning: If the software product has more than one license contract, then the
changes are applied to all the licenses of the current product.

You can also edit a software license from the ITMS Management Views.

See “Edit License Rule dialog box” on page 77.

To view software license information from the ITMS Management Views, See
“Viewing license information in ITMS Management Views” on page 78.

Tracking the software license compliance
After you insert all necessary data and create the associations, you can track the
software license compliance in your environment.
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Note:Software products are linked to one or more software resources. The purpose
and benefit of a software product is not fully realized until Asset Management Suite
is installed. Installation of Asset Management Suite is a pre-requisite for creating
a licensed software product.

You can use the Software view or Resource Manager to check the software license
compliance of a single software. In the Licensing Reports Web Part, on the
Software Product Licensing Compliance tab, you can view the software license
compliance report for all your software.

To see the most accurate data in Resource Manager and in the Software Licensing
portal, the Software Product Licensing Recalculation Operation Taskmust run.
By default, this task is scheduled to run during off-peak hours. You can access the
task on the Jobs / Tasks page, under Jobs and Tasks > System Jobs and Tasks
> Service and Asset Management > Contract Management.

This task is a step in the process for managing your software license compliance
using the Software view.

See “Managing your software license compliance using the Software view”
on page 69.

See “Managing your software license compliance on the Asset Management Solution
pages” on page 86.

You can also track the software license compliance by location using the Software
Product Licensing Compliance By Location report. To view the report, ensure
that the installation location is associated with the software purchase and the
computers. Ensure that you run the Software Product Licensing Recalculation
Operation Task before generating the report to get the updated data.

To track your software license compliance in the Software view

1 In the Symantec Management Console, on theManagemenu, click Software.

2 In the navigation pane, under Licensed Software, click Licensed, and then
select a software product in the list pane.

3 In the software details pane, you can view the information about software usage
and software licenses.

For more information, click the page and then press F1.

Note that the software license compliance graphic does not include
non-inventoried, borrowed, or upgraded licenses. It only shows the count of
purchased licenses as compared to the count of software product installs
detected in the environment.
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To track your software license compliance in Resource Manager

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Software Licensing.

2 In the left pane, click Software Product.

3 In the Software Product list, right-click the software product, and then click
Resource Manager.

4 In Resource Manager, on the Summaries menu, click Software Product
Licensing Summary.

To track your software license compliance in the Software Licensing portal

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Software Licensing.

2 In the right pane, in the Licensing Reports Web Part, click the Software
Product Licensing Compliance tab.

To track your software license compliance by location in the Software Licensing
portal

1 In the Symantec Management Console, on theReportsmenu, clickAll reports.

2 In the Reports pane on the left, click Service and Asset Management >
Contract Management > Software Licensing > Software Product Licensing
Compliance By Location to view the software license compliance by location
report.

Alternatively, on the Home menu, click Service and Asset Management >
Software Licensing. In the left pane, click Service and Asset Management
Reports > Contract Management > Software Licensing > Software Product
Licensing Compliance By Location.

Alternatively, on the Home menu, click Service and Asset Management >
Manage Configuration Items. In the left pane, click Service and Asset
Management Reports > Contract Management > Software Licensing >
Software Product Licensing Compliance By Location.

Upgrading and renewing a software license
You can upgrade or renew a software license. Note that after you upgrade or renew
the software license once, the context menu options Upgrade Software License
and Renew Software License do not appear.

You can renew a software license when the following conditions are met:

■ For the software license, in the Advanced View dialog box, under Contract
Details, the Renewable option is checked.
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■ The software license is not expired.

■ The software license is associated with a software purchase that has quantity
data specified.

This task is a step in the process for managing your software license compliance
on the Asset Management Solution pages.

See “Managing your software license compliance on the Asset Management Solution
pages” on page 86.

To upgrade a software license

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Software Licensing.

2 In the left pane, click Software License.

3 In the right pane, right-click a software license, and then click Contract
Functions > Upgrade Software License.

4 In theUpgrade an existing software license dialog box, to specify the settings
of the new software license, do the following:

■ For the Covered Software Product option, select a software product that
is different from the original software product.

■ Select one or more software purchases so that the quantity matches the
total number of original software licenses that you upgrade. Partial upgrade
is not supported.

■ Enter information in other data classes as required.

5 Click OK.

To renew a software license

1 In the Symantec Management Console, on theHomemenu, click Service and
Asset Management > Software Licensing.

2 In the left pane, click Software License.

3 In the right pane, right-click a software license, and then click Contract
Functions > Renew Software License.

4 In the Renew an existing software license dialog box, specify the settings
of the software license renewal.

Note that the quantity of the selected software purchases must match the
quantity of the licenses that you want to renew. Partial renewal is not supported.

5 Click OK.
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Viewing the Asset
Management Suite reports

This chapter includes the following topics:

■ Viewing the Asset Management Suite reports

Viewing the Asset Management Suite reports
The following table provides information about the different types of Asset
Management Suite reports that you can execute and view:

Table 9-1 Reports in Asset Management Suite

Navigation from the Symantec
Management Console

DescriptionReport

Reports menu > All Reports > Service
and Asset Management > Asset
Management > Accounting >
Depreciation Reports > Datasources

This is a parameterized query
report for asset types that is used
by theDepreciationByAssigned
Cost Center Detail and
Depreciation By Assigned Cost
Center reports.

Asset_Type Parameter Query

Reports menu > All Reports > Service
and Asset Management > Asset
Management > Accounting >
Depreciation Reports > Datasources

This is a parameterized query
report for cost center filter that is
used by the Depreciation By
AssignedCost Center Detail and
Depreciation By Assigned Cost
Center reports.

Cost Center Filter Parameter Query

9Chapter



Table 9-1 Reports in Asset Management Suite (continued)

Navigation from the Symantec
Management Console

DescriptionReport

Reports menu > All Reports > Service
and Asset Management > Asset
Management > Accounting >
Depreciation Reports > Datasources

This is a parameterized query
report for location filter that is used
by theDepreciationByAssigned
Cost Center Detail and
Depreciation By Assigned Cost
Center reports.

Location Filter Parameter Query

Reports menu > All Reports > Service
and Asset Management > Asset
Management > Accounting >
Depreciation Reports > Datasources

This is a parameterized query
report for range filter that is used
by theDepreciationByAssigned
Cost Center Detail and
Depreciation By Assigned Cost
Center reports.

Range Parameter Query

Reports menu > All Reports > Service
and Asset Management > Asset
Management > Accounting >
Depreciation Reports > Datasources

This is a parameterized query
report for period filter that is used
by theDepreciationByAssigned
Cost Center Detail and
Depreciation By Assigned Cost
Center reports.

Select Period Parameter Query

Reports menu > All Reports > Service
and Asset Management > Asset
Management > Accounting >
Depreciation Reports > Datasources

This is a parameterized query
report for purpose type filter that
is used by the Depreciation By
AssignedCost Center Detail and
Depreciation By Assigned Cost
Center reports.

Select Purpose Type Parameter
Query

Reports menu > All Reports > Service
and Asset Management > Asset
Management > Accounting >
Depreciation

This report lists the depreciation
amounts for assets and software
licenses based on cost centers.

Depreciation By Assigned Cost
Center

Reports menu > All Reports > Service
and Asset Management > Asset
Management > Accounting >
Depreciation Reports

This report lists the depreciation
amounts for assets and software
licenses based on cost centers.

Depreciation By Assigned Cost
Center Detail
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Table 9-1 Reports in Asset Management Suite (continued)

Navigation from the Symantec
Management Console

DescriptionReport

Reports menu > All Reports > Service
and Asset Management > Assets

This report returns a list of assets,
which can be filtered by the asset
owner's department. This may
include assets owned by the
specified department, rather than
a user.

Assets by Owner's Department

Reports menu > All Reports > Service
and Asset Management > Assets

This report returns a list of assets,
which can be filtered by asset by
type , status, department, cost
center, or location parameters.

Assets by Type, Status, Department,
Cost Center and Location

Reports menu > All Reports > Service
and Asset Management > Assets

This is a summary report of asset
types.

Count of Assets

Reports menu > All Reports > Service
and Asset Management > Assets

This report returns a list of all
configurable assets. Results can
be limited by selecting a specific
resource type.

General Asset Report

Reports menu > All Reports > Service
and Asset Management > Assets

This report provides a list of assets
owned by the given user.

Owned Assets

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Master Lease

This report lists assets that are
covered by a master lease
agreement.

Master Lease Covered Assets

Reports menu > All Reports > Service
and Asset Management > Contract
Management

This report returns a list of
contracts expiring within the
specified date range. The results
can be limited by contract type.

Contracts Expiring in N Days

Reports menu > All Reports > Service
and Asset Management > Contract
Management

This report returns a list of
contracts expiring within the
specified date range. The results
can be limited by contract type.

Contracts Expiring in N Days-Simple

Reports menu > All Reports > Service
and Asset Management > Contract
Management

This report returns a list of contract
types, with a count of managed
contracts for each type.

Count of Contracts by Type
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Table 9-1 Reports in Asset Management Suite (continued)

Navigation from the Symantec
Management Console

DescriptionReport

Reports menu > All Reports > Service
and Asset Management > Data Center

This report displays network
resources. If the filter is set to
"True", all network resources will
be displayed except for network
printers, and computer resources
of a computer type (workstation,
server, or test) with the Display
Server Fields check box cleared.

Network Resources Available For
Data Center

Reports menu > All Reports > Service
and Asset Management > Merge

This report lists all the assets that
share the same barcodes and
allows such duplicates to be
merged by clicking on it and
selecting merge assets from the
context menu.

Merge assets with duplicate
Barcodes

Reports menu > All Reports > Service
and Asset Management > Merge

This report lists all assets that
share the same serial numbers
and allows such duplicates to be
merged by clicking on it and
selecting merge assets from the
context menu.

Merge assets with duplicate Serial
Numbers

Reports menu > All Reports > Service
and Asset Management > Merge

This report lists all assets that
share the same system numbers
and allows such duplicates to be
merged by clicking on it and
selecting merge assets from the
context menu.

Merge assets with duplicate System
Numbers

Reports menu > All Reports > Service
and Asset Management > Organizational
Types > Cost Center

This report returns a list of cost
centers, which can be limited by
selecting a specific location.

List of Cost Centers by Location

Reports menu > All Reports > Service
and Asset Management > Organizational
Types > Department

This report shows a list of
departments, which can be filtered
by a specific location or cost
center.

Departments by Location and Cost
Center

Reports menu > All Reports > Service
and Asset Management > Organizational
Types > Location

This report returns a list of
locations, which can be limited by
selecting a specific cost center.

List of Locations by Cost Center
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Table 9-1 Reports in Asset Management Suite (continued)

Navigation from the Symantec
Management Console

DescriptionReport

Reports menu > All Reports > Service
and Asset Management > Parameters

This is a parameterized query
report that displays the asset
types. The report is used in
various reports like All Asset,
Count of Asset, General Asset
Reports, and so on.

Asset Type Parameter Query

Reports menu > All Reports > Service
and Asset Management > Parameters

This is a parameterized query
report that displays assets by
organizational types.

Assets By Organizational Types,
Status Query

Reports menu > All Reports > Service
and Asset Management > Parameters

This is a parameterized query
report that displays the asset
status. The report is used in
various reports like All Asset,
Count of Asset, General Asset
Reports, and so on.

AssetStatus Parameter Query

Reports menu > All Reports > Service
and Asset Management > Picker Reports
> Asset Management

This report displays all accounting
codes existing in the system.

All Accounting Codes

Reports menu > All Reports > Service
and Asset Management > Picker Reports
> Asset Management

This report lists all bundle items.All Bundles

Reports menu > All Reports > Service
and Asset Management > Picker Reports
> Asset Management

This report lists all catalog items.All Catalog Items

Reports menu > All Reports > Service
and Asset Management > Picker Reports
> Asset Management

This report lists all catalogs.All Catalogs

Reports menu > All Reports > Service
and Asset Management > Picker Reports
> Asset Management

This report lists all consumable
catalog items.

All Consumable Catalog Items

Reports menu > All Reports > Service
and Asset Management > Picker Reports
> Asset Management

This report returns all cost types
available.

All Cost Types
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Table 9-1 Reports in Asset Management Suite (continued)

Navigation from the Symantec
Management Console

DescriptionReport

Reports menu > All Reports > Service
and Asset Management > Picker Reports
> Asset Management

This report lists all currencies.All Currencies

Reports menu > All Reports > Service
and Asset Management > Picker Reports
> Asset Management

This report lists all the depreciation
schedules. Depreciation schedules
are used as part of the cost model
feature to define the yearly
depreciation rate.

All Depreciation Schedules

Reports menu > All Reports > Service
and Asset Management > Picker Reports
> Asset Management

This report lists all fixed asset
catalog items.

All Fixed Asset Catalog Items

Reports menu > All Reports > Service
and Asset Management > Picker Reports
> Asset Management

This report lists all invoices.All Invoices

Reports menu > All Reports > Service
and Asset Management > Picker Reports
> Asset Management

This report lists all purchase
orders.

All Purchase Orders

Reports menu > All Reports > Service
and Asset Management > Picker Reports
> Asset Management

This report lists all purchase
requests.

All Purchase Requests

Reports menu > All Reports > Service
and Asset Management > Picker Reports
> Asset Management

This report lists all receiving slips.All Receiving Slips

Reports menu > All Reports > Service
and Asset Management > Picker Reports
> Asset Management

This report lists all software
catalog items.

All Software Catalog Items

Reports menu > All Reports > Service
and Asset Management > Picker Reports
> Asset Management

This report displays all software
licenses which satisfy the given
search conditions.

All Software Licenses

Reports menu > All Reports > Service
and Asset Management > Picker Reports
> Asset Management

This report lists all software
purchases.

All Software Purchases

Reports menu > All Reports > Service
and Asset Management > Picker Reports
> Asset Management

This report lists all stockrooms.All Stockrooms
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Table 9-1 Reports in Asset Management Suite (continued)

Navigation from the Symantec
Management Console

DescriptionReport

Reports menu > All Reports > Service
and Asset Management > Picker Reports

This report list all contracts
marked as active listed by
assigned owner

Active Contracts by User

Reports menu > All Reports > Service
and Asset Management > Picker Reports

This report returns a list of assets,
filtered by asset type, status and
common organizational types.

All Assets

Reports menu > All Reports > Service
and Asset Management > Picker Reports

This report returns a list of assets,
filtered by asset type, status and
common organizational types.

All Assets-Simple

Reports menu > All Reports > Service
and Asset Management > Picker Reports

This report returns a list of all
computer types.

All Computer Types

Reports menu > All Reports > Service
and Asset Management > Picker Reports

This report returns a list of all
computer resources.

All Computers

Reports menu > All Reports > Service
and Asset Management > Picker Reports

This report lists information of
contracts which satisfy the given
search criteria.

All Contracts

Reports menu > All Reports > Service
and Asset Management > Picker Reports

This report lists all cost centers.All Cost Centers

Reports menu > All Reports > Service
and Asset Management > Picker Reports

This report lists all departments.All Departments

Reports menu > All Reports > Service
and Asset Management > Picker Reports

This report lists all locations.All Locations

Reports menu > All Reports > Service
and Asset Management > Picker Reports

This report returns a list of all
office equipment resources.

All Office Equipment

Reports menu > All Reports > Service
and Asset Management > Picker Reports

This report returns a list of all
phone resources. The results can
be limited by selecting a specific
phone type.

All Phones

Reports menu > All Reports > Service
and Asset Management > Picker Reports

This report returns a list of all
power resources.

All Powers

Reports menu > All Reports > Service
and Asset Management > Picker Reports

This reports returns a list of all
rack resources.

All Racks
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Table 9-1 Reports in Asset Management Suite (continued)

Navigation from the Symantec
Management Console

DescriptionReport

Reports menu > All Reports > Service
and Asset Management > Picker Reports

This report returns a list of all UPS
resources.

All UPS

Reports menu > All Reports > Service
and Asset Management > Picker Reports

This report returns a list of all user
resources. The results can be
limited by selecting a specific
location, department, or company.

All Users

Reports menu > All Reports > Service
and Asset Management > Procurement

This report lists all procurement
items that have line items that
have not been transitioned to the
next step and therefore are
considered incomplete. This does
not include receiving slips as by
definition they are always
complete.

Incomplete Receiving Items

Reports menu > All Reports > Service
and Asset Management > Workflow

This report displays critical errors.Critical Error Report

Reports menu > All Reports > Service
and Asset Management > Workflow

This report displays workflow
projects and their associated
assemblies.

Workflow Project Assemblies

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report lists authorized installs
for the given software product,
limited by filters in Computer
authorization group.

Authorized Installs By Computer
Filter For Software Product

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report lists authorized installs
for the given software product,
limited by filters in owner
authorization group.

Authorized Installs By Owner Filter
For Software Product

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report lists authorized installs
for the given software product,
limited by filters in primary user
authorization group.

Authorized Installs By Primary User
Filter For Software Product
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Table 9-1 Reports in Asset Management Suite (continued)

Navigation from the Symantec
Management Console

DescriptionReport

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report displays the software
licenses where a quantity of
licenses have been borrowed from
another software license. This is
usually done to cover down-grade
rights where a newer version
license is used for an older
version.

Borrowed Licenses for Software
Product

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report lists all computers that
have inventoried installs for a
particular software product, where
the computer's owner also has
non-inventoried installs assigned
in the 'Non Inventoried Installs'
Data Class for the same software
license. The data used by this
report is taken from stored data
which is calculated on a schedule.

Computers with Inventoried and Non
Inventoried Installs

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report displays the software
licenses where a quantity of
licenses have been donated to
another software license. This is
usually done to cover down-grade
rights where a newer version
license is used for an older
version.

Donated Licenses For Software
Product

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report displays a list of
software products with number of
installs detected.

Inventoried Installs For Software
Product

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report displays all 6.5 legacy
software licenses to migrate to the
latest Asset Management Solution.
Right-click a license to initiate the
migration wizard.

List of legacy 6.5 Software Licenses
to be migrated

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report provides summary
information of Software Licenses
covered by this Master License
Agreement.

Master License Agreement Summary
Report
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Table 9-1 Reports in Asset Management Suite (continued)

Navigation from the Symantec
Management Console

DescriptionReport

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report provides a list of
software products with number of
installs that were entered
manually. This commonly for
systems that have not been
inventoried.

Non-Inventoried Installs For Software
Product

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report lists all the purchased
software licenses which are
currently active for the given
software product.

Purchased Licenses For Software
Product

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report displays software
licenses where a quantity of
licenses have been borrowed or
donated from another software
license. This is usually done to
cover down-grade rights where a
newer version license is used for
an older version.

Software License Sharing

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report displays software
products using the authorized
users feature with authorized
users inventory counts.

Software License's Authorized
Clients

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report displays the given
software license's non-inventoried
installs information.

Software License's Non-Inventoried
Installs

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report displays purchase
information for a given software
license.

Software License's Purchased
Quantity
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Table 9-1 Reports in Asset Management Suite (continued)

Navigation from the Symantec
Management Console

DescriptionReport

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report shows the compliance
for the given Software Product, the
Name field filters the Software
Product list by name. The data
used by this report is taken from
stored data which is calculated on
a schedule. To adjust the
frequency of this calculation,
modify the settings given in the
Software License evaluation
page under settings.

Software Product Licensing
Compliance

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report shows the compliance
for the given Software Product by
location. The Name field filters the
Software Product list by name.
The data used by this report is
taken from stored data which is
calculated on a schedule. To
adjust the frequency of this
calculation, modify the settings
given in the Software License
evaluation page under settings.

Software Product Licensing
Compliance By Location

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report provides details on
how many times a given
sofReports menu > All Reports
> Service and Asset
Management > Contract
Management > Software
Licensing

tware product has been run on
each client.

Software Product Usage Details

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This is a parameterized query
report that displays information
about how many number of times
a given software product has been
run on each client.

Software Product Usage Details
Query
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Table 9-1 Reports in Asset Management Suite (continued)

Navigation from the Symantec
Management Console

DescriptionReport

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report shows all the software
license contracts that are assigned
to a computer and the owner of
the computer. The report is most
useful to look at an individual
computer. The information is
current as of the last software
license evaluation run.

Software Products by Computer,
Owner

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report displays products using
the authorized users feature with
unauthorized users inventory
counts.

Unauthorized Installs For Software
Product

Reports menu > All Reports > Service
and Asset Management > Contract
Management > Software Licensing

This report displays summary
information of software licenses
covered by the virtual license
agreement.

Virtual License Agreement Summary
Report
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Reference topics

This appendix includes the following topics:

■ Predefined asset management security roles

■ Predefined configuration item types

■ About configuration item associations

■ About data input masks

■ Receive Items page

■ Software purchase item attributes

■ Software license item attributes

Predefined asset management security roles
When you install Asset Management Suite, the system automatically adds the
predefined asset management security roles to the Symantec Management Console.
The predefined security roles get automatically assigned the privileges and the
permissions that their respective jobs and tasks require.

See “Managing security on an organizational group” on page 27.

Table A-1 Predefined asset management security roles

DescriptionSecurity role

This security role has privileges for managing the basic
configuration item types. The security role also has privileges for
the managing functions that are related to special contract types,
software licensing, and procurement.

Asset Managers

This security role is a restricted data entry user role.Barcode User

AAppendix



Table A-1 Predefined asset management security roles (continued)

DescriptionSecurity role

This security role has privileges for managing basic configuration
item types, such as hardware and the base contract configuration
item type.

CMDB Managers

Predefined configuration item types
Predefined configuration item types (also known as predefined resource types) are
the templates that define what data is created and stored about a specific
configuration item.

Asset Management Suite provides predefined configuration item types for many
types of assets. You can add custom fields to the predefined configuration item
types. You can also create new configuration item types, if required. However,
Symantec recommends that you use predefined configuration item types, because
different features and reports are available for the predefined configuration item
types.

Table A-2 Predefined configuration item types of Asset Management Solution

Predefined configuration item typesCategory

Lease Schedule, Master Lease, NDA, Warranty

See “Managing contracts” on page 52.

Contract Management
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Table A-2 Predefined configuration item types of Asset Management Solution
(continued)

Predefined configuration item typesCategory

■ Accounting Code
An accounting code contains an ID number and a description that
corresponds with a budgetary division, such as a department or division.
You can associate the accounting code with the cost items to help you
allocate expenses to resources, such as computers and purchase orders.

■ Cost Type
You use a cost type item to specify a type of expense. For example, you
can designate cost types as an external purchase, external support,
internal support, or contract. Cost type items let you logically group
expenses. Cost type attributes affect depreciation values, group allocation,
and other reporting areas.

■ Currency
By default, Asset Management Suite defines no currency types or
currency rates. It provides a single, non-defined base currency for all
monetary entries. Symantec recommends that you define your base
currency so that you can use the currency convertor. Symantec
recommends that you set the rate of the base currency to 1.00. You then
set other currencies to their respective exchange rates as they compare
to the base currency.

■ Depreciation Schedule
The depreciation schedule lets you specify the rates and the dates that
are associated with depreciating assets and other resource items. You
create the depreciation schedule items that correspond to your
depreciation expense strategies. When you create a depreciation schedule
item, you enter attributes, such as description, depreciation type, and
rate. You can use these items and attributes to generate the reports that
are associated with the assets and depreciation.

■ Cost Item
A cost item is an expense that relates to or adds value to a resource.
See “Adding a cost item to an asset” on page 39.

Financial Types

Invoice,PurchaseOrder,PurchaseRequest,Receiving Slip,Stockroom.Procurement

Bundle, Catalog, Consumable Catalog Item, Fixed Asset Catalog Item,
Software Catalog Item.

Catalogs

Software Product, Master License Agreement, Software License,
Software Purchase, Virtual License Agreement.

Software Licensing
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Table A-3 Predefined configuration item types of CMDB Solution

Predefined configuration item typesCategory

Contract, SLA

See “Managing contracts” on page 52.

Contract Management

Cell Phone, Desk Phone.Communication Equipment

Computer, Monitor, Network Printer, Peripheral, Scanner, Virtual
Machine.

Computers and Peripherals

■ Computer Type
Includes the predefined Server, Test, and Workstation types to let you
specify what type of function or role a computer has. You determine the
computer type when you edit or create a new computer configuration
item.

■ Power
The power sources that the network uses and that are intended to be
associated with UPS configuration items.

■ Rack
Network resource racks. You can specify which network resources are
included in each rack.

■ Services
The functions that support one or more business areas. For example,
the Service configuration item type lets you manage the information
about your email service. Email service consists of several components
such as Active Directory, Exchange Server, and Web Mail. Each of these
components might be located on a separate server. When you set up
the email service in the Symantec Management Console, you first create
the systems that support this service. After you create the systems, you
create the Service and in the Create configuration item window, under
Supporting Systems, you add all related systems. When you then
receive an incident that is related to the email service, you can use the
Resource Association Diagram to track down the problem. The Resource
Association Diagram lets you quickly view all the components that are
connected to this particular service.
See “Tracking the associations of a configuration item” on page 41.

■ Systems
The components that support services. For example, an Exchange Server.

■ UPS
Uninterrupted power supply resources. Includes the details on voltage,
input and output frequencies, currents, and so on.

Datacenter Types

Asset, Network Resource.Generic Asset Types
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Table A-3 Predefined configuration item types of CMDB Solution (continued)

Predefined configuration item typesCategory

Furniture and Fixtures, Office Equipment, Site, Subnet.Other Assets

Company, Cost Center, Department, Location, User.Organizational Types

About configuration item associations
Understanding the relationships between various configuration item types, especially
the crucial organizational configuration item types, helps you to identify the
dependencies within the Configuration Management Database (CMDB). You can
view relationships between configuration items in the Resource Association Diagram
that you access in the Resource Manager, in the left pane.

See “Tracking the associations of a configuration item” on page 41.

Not all configuration item types can have direct associations with each other but
most of them have indirect associations with each other. Associations are useful
for reporting purposes. For example, a computer asset is associated with a user
and the user is associated with a department. Although the asset may not be directly
associated with the department, the asset is reported as one of the department’s
assets.

The following table shows direct configuration item type associations. The
configuration item type column presents the child (from) configuration item type,
and the direct association column presents the parent (to) configuration item types.

Table A-4 Direct associations of configuration item types

Direct associationConfiguration item
type

Cost Center, Location, User, Department, and Asset.Asset

Location and Manager (User).Cost Center

Cost Center, Location, and Manager (User).Department

Cost Center and Manager (User).Location

Company, Department, Location, and Manager (User).User

The following table shows indirect configuration item type associations, including
the path for creating the association. The configuration item type column presents
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the child (from) configuration item type, and the indirect association column presents
the parent (to) configuration item types.

Table A-5 Indirect associations of configuration item types

Indirect associationConfiguration item
type

User > Company

User > Department

User > User

Asset

Cost Center > UserDepartment

Cost Center > UserLocation

Existing Users can be specified as Managers.Manager

Department > Cost Center

Department > Location

User

About data input masks
Data input masks are the filters that selectively include or exclude certain values.
When you define a data class, you can assign the masks that indicate what sort of
value the data class attributes should hold. Values that do not conform to the mask
cannot be entered.

See “Creating a custom data class” on page 43.

Table A-6 Data input mask characters

MeaningCharacter

Any letter. Entry required.A

Any letter. Entry optional.a

Any digit or space. Entry optional; “+” and “-” not allowed.9

Any digit (0 to 9). Entry required; “+” and “-” not allowed.0

Any letter, digit, space, “+”, or “-”. Entry optional; spaces are
removed when data is saved.

*

Any letter, digit, “+”, or “-”. Entry required.#
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Table A-6 Data input mask characters (continued)

MeaningCharacter

Treat the masking character following the “\” as a regular character
with no special masking properties.

\

Receive Items page
The Receive Items page lets you receive different catalog item types and specify
how you want to receive them. For example, you can place the consumable catalog
items in a stockroom or add them as cost items to an asset. You can add new fixed
asset catalog items to your database or update the data of the existing assets. You
can add a new software purchase configuration item or update the data of the
existing software purchase.

When you receive items, a receiving slip is automatically created as a record.

See “Receiving an item” on page 67.

Table A-7 Options on the Receive Items page

DescriptionOption

Lets you specify the Line Items that you want to receive.Receiving Item

Lets you specify the stockroom where you want to place the items that you
receive.

Receive To Stockroom
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Table A-7 Options on the Receive Items page (continued)

DescriptionOption

Lets you specify how you want to receive the items:

■ Create a new Resource
Lets you create a new resource for a fixed asset catalog item or for a software
catalog item. For example, when you create a new monitor configuration item,
all relevant information from the fixed asset catalog item is copied to the new
resource. Additionally, you can specify System Number, Serial Number
and Barcode.

■ Update an existing Resource/Add the Consumable to a Stockroom
Lets you update an existing resource or add consumable catalog items to a
stockroom.
If you update an existing resource, specify the individual resource that you
want to update in the Existing Resource/Stockroom field, in the Received
Item Line Items table.
If you add consumable items to a stockroom, specify the stockroom in the
Existing Resource/Stockroom field, in theReceived Item Line Items table.

■ Add as a Cost Item to an existing Resource
For example, you can add a new hard drive as a cost item to a computer. In
this case, you need to specify this computer in the Existing
Resource/Stockroom field, in the Received Item Line Items table.

The items should be received as

Lets you select the data classes for which you want to add or edit the data.

The default values are as follows:

■ The Received Asset’s Status is In Stock.
■ TheReceived Asset's Location of the asset is the location of the stockroom

to which the item is received.
■ The Manufacturer, and Model information is taken from the catalog item

data.

Parameters
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Table A-7 Options on the Receive Items page (continued)

DescriptionOption

Received Item Line Items
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Table A-7 Options on the Receive Items page (continued)

DescriptionOption

Lets you specify additional data for each Line Item and select the items that you
want to receive.

For a consumable catalog item you can specify Display Name, Quantity and
Owner. If the system detects in the stockroom the same consumable item of the
sameOwner, the quantity of the item is increased. TheOwner of the consumable
catalog item can be a cost center or a department.

When you receive a consumable catalog item as a cost item to an existing
resource, you must specify the Existing Resource to which you want to add the
item. A cost item is added to the cost center or the department for which the
consumable item has been ordered.

When you receive fixed asset catalog items, one line per item is created in the
Received Item Line Items table. For example, when you purchase three new
laptops, the Received Item Line Items table displays three separate lines, all
with quantity of 1.

The receiving process handles the data of a fixed asset catalog item as follows:

■ The Catalog Item field defines the asset type.
■ The Display Name field defines the name of the configuration item.
■ The Owner field defines the Asset Owners.
■ The Description of the receiving item is added to the Comment field of the

new asset.
■ The Asset’s associated catalog item association is set.
■ You can specify System Number, Serial Number and Barcode values.

Symantec recommends that you insert the Serial Number of a computer
when receiving it. When inventory runs and finds an item with this serial
number, it creates an association between the inventory record and the asset
record.

■ If you update an asset that is already created in the database, specify the
Existing Resource/Stockroom that you want to update. The details, such
as Barcode, Manufacturer, Status or Location, are only added when the
existing asset does not have them specified.

When you receive a new software catalog item, a new software purchase
configuration item is created.

The receiving process handles the data of each software catalog item as follows:

■ The Display Name field defines the name of the software purchase.
■ The Owner field defines the Software Purchase Owners.
■ The Description of the receiving software catalog item is added to the

Comment field of the software purchase.
■ The Software Purchases' Associated Catalog Item association is set.
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Table A-7 Options on the Receive Items page (continued)

DescriptionOption

The Quantity of the software catalog item is written to the Quantity field of
the software purchase.

■

■ The System Number, Serial Number and Barcode fields are ignored.
■ If you update a software purchase configuration item that is already created

in the database, specify the Existing Resource/Stockroom that you want
to update.

Lets you receive and generate receiving slips for all Line Items.Receive all

Lets you receive and generate receiving slips for selected Line Items.Receive selected

Software purchase item attributes
When you create a software purchase item, you specify its attributes and
associations with other configuration items in your system.

The attributes that are listed in the table are displayed when in the View drop-down
list, you select the Software Purchase (global) view.

Table A-8 Software purchase item attributes

DescriptionAttribute

Lets you insert the name of the software purchase item.

Symantec recommends typing a name that uses a combination of the software
name, software version, purchase date, and number of licenses. For example,
you can type the following as a software purchase name: Norton Ghost 15.0
5May2011 (10 Licenses).

Software Purchase

Lets you specify the details that are related to purchasing the software. You can
specify the purchase date, description, and number of licenses.

Software Purchase Details

Lets you enter the costs that are associated with purchasing the software licenses.Cost Items

Lets you associate and allocate the cost to departments and users.Software Purchase Owners

Lets you associate and allocate the purchase cost to one or more cost centers.Software Purchase Cost Center
Ownership

Lets you associate a location.Installed Location

Lets you associate the software purchase with an item from the procurement
Software Catalog.

Software Purchases' Associated
Catalog Item
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Table A-8 Software purchase item attributes (continued)

DescriptionAttribute

Lets you specify the book depreciation schedule to be used.Book Depreciation

Lets you specify the custom depreciation schedule to be used.Custom Depreciation

Lets you specify the tax depreciation schedule to be used.Tax Depreciation

Lets you specify reference information, such as account number, internal
reference ID, internal contact, archive number, and cross reference.

Internal Reference

Software license item attributes
When you create a software license item, you specify its attributes and associate
it with other configuration items in your system.

Note that the attributes that are listed in the table are displayed when in the View
drop-down list, you select the Software Licenses (global) view.

Table A-9 Software license item attributes

DescriptionAttribute

Lets you specify a name for the software license item.Software License

Lets you specify which software product is associated with the software license
contract.

To ensure the data integrity, you can add only one software product item to a
software license item.

Covered Software Product

Lets you enter standard contract information.Standard Contract Information

Lets you record the software license details. You can specify maintenance
renewal cost, support renewal cost, and license type.

Software License Details

Lets you specify the software purchases that are associated with the software
license item. You can associate one or more software purchases to the software
license item. Note that you can associate multiple software purchases to the
software license item only when you use manual process of managing your
software license compliance.

To ensure the data integrity, you can add each software purchase item only to
one software license item.

Software Purchases
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Table A-9 Software license item attributes (continued)

DescriptionAttribute

Lets you specify the users, computers, and owners that are authorized to run
the software. You can use the Add option to add an authorized client. Note that
you can specify authorized client information only when you use the manual
process of managing your software license compliance.

You can specify the following options:

■ Clients – lets you select a filter that contains the computers, users, or owners
that are authorized to run the software. The results of the selected filter must
consist of only one configuration item type. The results cannot combine
computer and user configuration item types.

■ Authorization Group – lets you specify the configuration item type resulting
from the filter, either Computer, Owner, or Primary User.

To specify additional filters, you can add more rows to the grid. Each row is
treated as an OR condition. The client is authorized for the software license if
any condition in any row is met.

Authorized Clients

Lets you enter the details to track the number of software installations on the
computers that are not inventoried or discovered.

Non Inventoried Installs

Lets you specify the details about sharing the software licenses.

If the software license item borrows licenses from other software license items,
select the appropriate software license and specify the number of borrowed
licenses.

Software License Sharing

Lets you specify the user that is assigned to the software license contract.Contract's Assigned User

Lets you specify the location of the software license contract.Contract's Location

Lets you enter any details that correspond to the software license contract. You
can select a filter to specify to which user or computer the software license
contract applies.

Contract Details

Lets you enter comments about the software license.Comment
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Table A-9 Software license item attributes (continued)

DescriptionAttribute

Lets you specify the documents that are associated with the software license
contract. You can use the Add option to add an associated document.

You can specify the following options:

■ File - lets you enter the path to the document. The path must be specified as
a UNC path. The following file path is not supported:
C:\document.txt

To specify a file on the local computer, you can set up its location as a network
share as follows:
\\Computer\share\document.txt

■ Description - lets you enter a description of the document.

Associated Documents

Lets you enter the internal reference information. For example, you can enter
the account number, internal contact, and archive number.

Internal Reference

Lets you specify the former software license item that represents the previous
software license contract.

This option is available only when you upgrade or renew a software license.

Former Software License (if
renewed or upgraded)

Lets you specify the new software license item that represents the upgraded
software license contract.

This option is available only when you upgrade or renew a software license.

NewSoftware License (if renewed
or upgraded)
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bundle A container that is used to group frequently ordered catalog items together.

data input mask A filter that selectively includes or excludes certain values.

procurement catalog A component of Asset Management that contains the information that is necessary
for requesting consumables, assets, or software.

user configuration item

type

A component of Asset Management that is used to enter the data about the company
workers into the CMDB (Configuration Management Database).

Glossary
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